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December 17,2023

Every Citrix product environment must have at least one shared or dedicated License Server. License
servers are computers that are partly or fully dedicated to storing and managing licenses. Citrix prod-
ucts request licenses from a License Server if users attempt to connect.

Servers running Citrix products contact the License Server to obtain licenses.

If users connect to a Citrix product, it draws licenses from the License Server. The Citrix product re-
quests to check out a license from the License Server on behalf of the user or client device. When the
license is successfully checked out, the user can run the product.
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-
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License Server

Single Sign-On

LOEE Citrix product

sanvers
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User devices

Depending on the size and configuration of your product deployment, you might deploy licensing on
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a server shared with other applications, a dedicated License Server, or multiple License Servers.

License files must be on the License Server that is associated with the product you are licensing. The
product must be configured to communicate with that specific License Server. The Citrix Licensing
Manager lets you manage and monitor your Citrix licenses by providing a user interface to the License
Server. You can view licenses and alerts, import license files, create historical usage reports, and man-
age License Server settings.

Product-specific licensing information

« Citrix ADC

« Citrix Cloud

« Citrix Endpoint Management

« Citrix Gateway

« Citrix Hypervisor

« Citrix Virtual Apps and Desktops

What’s new

December 18, 2023

What’s new in the License Server build 34000

Release date: March 17, 2021

Lmadmin.exe transitioned to Lmgrd.exe

In this release, the Citrix License Server’s existing user management Ilmadmin.exe is transitioned to
Citrix owned user management Imgrd.exe for improved security and less 3rd party dependencies.

OpenSSL version upgrade

OpenSSL version: 1.1.1h

Libxml2 version upgrade

libxml|2 version: 2.9.10
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What’s new in the License Server build 33000

Release date: December 15,2020

A new configuration option added to the Configure usage telemetry

« With the new option under Configure usage telemetry you can choose not to send data or to
send data in an unidentifiable format.

For more information, see Configure usage telemetry.

Apache version update

Apache version 2.4.46.

OpenSSL version upgrade

OpenSSL1.1.1g

What’s new in the License Server build 32000

Release date: September 29, 2020

Enhancement to the Settings and Historical Use sections

« In the Citrix License Manager > Settings > Usage and Statistics screen, use the Configure
usage telemetry to manage data privacy preferences related to user name or device ID details.

For more information, see Configure usage telemetry.

+ In the Citrix License Manager > Historical Use > Customer Success Services Date field, All
is the new default option in the menu. It is used to export data for multiple Customer Success
Services dates.

jQuery version update

The Citrix Licensing Manager is upgraded to jQuery version 3.5.1.
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What’s new in the License Server build 31000

Release date: June 17,2020

Removal of the Citrix License Administration Console

The Citrix License Administration Console was removed from this version of the License Server. Use
the Citrix Licensing Manager.

Apache version upgrade

Apache v2.4.43

OpenSSL version upgrade

OpenSSL1.1.1e

Older cipher suite support

TLS 1.0 and 1.1, DES, 3DES, RC4, and MD5 cipher suites are not supported. If removal of these
cipher suites causes an issue for older versions (released before 2009) of Studio and Director then
change the SSLEngine configuration in C:\Program Files (x86)\Citrix\Licensing\
WebServicesForLicensing\Apache\conf\extra\httpd-ssl.conf.

Fixed issues

December 5, 2023

Fixed issues in License Server build 34000

+ Inthe Citrix Licensing manager > Settings > Account > User Administration section, the User-
name/Group name in the Japanese language or double-byte characters appear garbled. The
registered double-byte User/Group names cannot log on to the Citrix Licensing Manager. [LIC-
2032]
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Fixed issues in License Server build 33000

There are no fixed issues in this build.

Fixed issues in License Server build 32000

« License Servers on Kernel-based Virtual Machines (KVMs) might be unable to successfully send
reports to the License Usage Insights Service. [LIC-2555]

« Licenses with expiry date incorrectly formatted as D-MMM-YYYY appear as permanent in Stu-
dio. Use the Citrix Licensing Manager to display the correct license expiration dates. [LIC-2556]

« When used with concurrent licenses, the License Server build 31000 is not backward compati-
ble with the Citrix Virtual Apps (previously, XenApp) 6.5 and earlier version. Use License Server
v11.16.6 build 32000.[LIC-2807]

Fixed issues in License Server build 31000 and earlier

+ When you access the Citrix Licensing Manager from the Start menu for the first time after instal-
lation, an error message might appear on Firefox and Chrome browsers. [LIC-195]

+ Inadouble-hop scenario, a single user might consume two Citrix concurrent user (CCU) licenses.
Double hop is when a user launches the HDX session within another HDX session (for example,
when you launch a published application within a virtual desktop session). [CVADHELP-14150]

Known issues

December 5, 2023

Known issues in License Server build 34000

+ In a cross-domain environment, the Citrix Licensing Manager and POSH cmdlet support only
two-way trust to add a user.

With the external trust(one-way trust), the Citrix Licensing Manager, and the POSH cmdlet displays
the following error message Active Directory account resolution failed.

Werecommend that you run the CtxManageUserAndGroup.exe from the ‘Citrix\Licensing\LS\resource’
location with the following parameters:
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- Command to add a user: CtxManageUserAndGroup.exe —-useradd “domain\username”
-Role “admin/user”

-Commandtoadd agroup: CtxManageUserAndGroup.exe —useradd “domain\username

” —Role “adminGroup/userGroup

Forexample, ifdomainl has an outgoing trust to domain2, then a user from domain2 can authenticate
in domainl and add a user to License Server using the executable only. [LIC-3268]

Known issues in License Server build 32000 and earlier

« Inthe Citrix Licensing manager > Settings > Account > User Administration section, the User-
name/Group name in the Japanese language or double-byte characters appear garbled. The
registered double-byte User/Group names cannot log on to the Citrix Licensing Manager.

The workaround is to use English user/group names or without double-byte characters. [LIC-
2032]

Known issues in License Server build 31000 and earlier

+ User/Device license fails to checkout with a space in the username and displays the following
error message:

Error: checkoutOutBatch failed: Error_UNEXPECTED_DATA: Unexpected
server response 'UD: ERROR_SYNTAX'

Use the License Server build 30000 as a workaround. [LIC-3506]

+ The Citrix Licensing Manager does not differentiate between users and groups. For example,
you can choose to add a user but add a group instead. [LIC-438]

« The Windows 2016 Start menu, might not list the Citrix Licensing Manager. Workaround: Use
this URL to access the console:

https://licenseservername: 8083 [LIC-506]

+ When registering your License Server with Citrix Cloud, the Citrix Licensing Manager Ul might
stick and display a spinning wheel. To avoid this issue, before registering your License Server
with Citrix Cloud, ensure that you have the Digicert Global Root CA certificates installed in the
system. These certificates are updated in the Windows update. If they’re notinstalled, manually
download and install the certificates before starting the Citrix Cloud registration. Also, ensure
you verify firewall settings. For more information, see the Important note under Register and
remove registration with Citrix Cloud. [LIC-1510]

+ License Servers on Kernel-based Virtual Machines (KVMs) might be unable to successfully send
reports to the License Usage Insights Service. [LIC-2555]
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« When used with concurrent licenses, the License Server build 31000 is not backward compati-
ble with the Citrix Virtual Apps (previously, XenApp) 6.5 and earlier version. Use License Server
v11.16.6 build 30000.[LIC-2807]

License file issues

+ The License Server ignores license files that have multiple lines referencing HOSTNAME=. Li-
censes in these files cannot be checked out. This issue is caused when you download licenses
associated to different License Server host names in to the same license file.

To resolve this issue, download again separate license files for each Citrix product tied to differ-
ent License Server names.

« Licenses with expiry date incorrectly formatted as D-MMM~-YYYY appear as permanent in Stu-
dio. Use the Citrix Licensing Manager to display the correct license expiration dates. [LIC-2556]

Third party notices

July 12,2021

Citrix Licensing 11.16.6 might include third party software licensed under the terms defined in the
following documents:

« Non-Commercial Software Disclosures For FlexNet Publisher 2020 (11.16.6) (PDF download)

+ FlexNet Publisher Documentation Supplement Open Source Licenses applicable to FlexNet Pub-
lisher 11.16.6 (PDF download)

System requirements for Citrix Licensing

October 7, 2023

Requirements for Licensing

Citrix Licensing is compatible with the same hardware required to support the compatible operating
systems. Extra hardware is not required.
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Notes:

« We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

+ TheLicense Server does not support multi-homing (two network cards plugged into distinct
networks).

+ The Citrix Licensing Manager installs licenses only on the License Server where itis installed.

« License Servers don’t communicate with each other.

Operating system:

You can install the License Server on servers running the following Microsoft operating systems. We
recommend that you install the latest Microsoft Service Pack and updates.

« Windows Server 2019 Family
« Windows Server 2016 Family
« Windows Server 2012 R2 Family

Server Core installations are not supported.

Disk space requirement:

+ 161 MB for the licensing components

+ 2 GB for user/device licensing

+ More disk space might be required based on the amount of historical data that is configured in
the Citrix Licensing Manager.

Microsoft .NET Framework minimum requirements:
« Microsoft .NET Framework 4.7.2
Cluster platforms:

« Windows Server 2019 Family
« Windows Server 2016 Family
« Windows Server 2012 R2 Family

Browsers:

We tested the following browsers. Other browsers might work, but all functionality might not be avail-
able.

+ Microsoft Edge
+ Mozilla Firefox
+ Google Chrome
+ Safari
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What’s next

+ Get started, install, and configure the License Server

Licensing FAQ

December 18, 2023

The following questions are asked frequently about your licensing environment.

Licenses
What is a license file and what do 1 do with it?

The license file is a text file that contains the following:

+ Product licensing information
« License Server name (or other binding identifier)
« Customer Success Services membership renewal date

License expiration date (if applicable)
+ Other system information

When you purchase a Citrix product and allocate licenses, a license file is generated. The License
Server uses this file to determine whether to grant a license to a Citrix product. For more information,
see License files.

Why would I return a license?

An example would be if you’re decommissioning a License Server, but you’re not ready to deploy
existing licenses elsewhere. For more information, see Return allocations.

What happens to returned licenses?

Returned licenses are put back in the licensing pool. You can then allocate these licenses in any quan-
tity at any time. After you return a license, remove the old license file from the License Server. For
more information, see Return allocations and Modify licenses.
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What happens when | hide a license?

Hide (previously called archiving) doesn’t remove licenses from an account. Hiding removes them
from view. To view hide and unhide licenses, see Hide and unhide licenses.

How can | get a copy of my license file?

You can obtain a copy of your license file from your License Server. Alternatively, all purchased licenses
and allocated license files are available from the secure My Account > Manage Licenses portal at
www.citrix.com.

Allocating licenses

For more information about allocating licenses, see Allocate licenses.

What does allocating licenses mean?

When you allocate licenses, you apportion purchased licenses by product and License Server so you
can split them among multiple environments or use cases. For example, your organization might
own 1,000 licenses for the same product. You might want to use 800 in 1 location and 200 in another
location. You can allocate 800 licenses to a License Server in the first location today, and allocate the
remaining 200 later to a different License Server.

What’s the difference between a host ID type and a host ID?

The host ID type is the required binding type you supply to allocate licenses. The host ID is the License
Server host name, MAC address, or other binding ID required to allocate licenses.

Why can’t | partially allocate some licenses?

Some licenses do not allow partial allocation.

The License Server
Can | rename the License Server?

License files run only on the License Server that is bind during the license allocation. License files
contain the host name or binding identifier of the License Server you specify when you allocate the
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licenses. You cannot use the license file that you generated for a particular License Server or a MAC
address (for an appliance), on a different License Server or appliance.

Create license files that reference the new server name or MAC address by returning allocations
and generating the new file on citrix.com. For more information, see Manage Licenses on
citrix.com.

If | upgrade my License Server does it affect my license files?

No. The License Server and all product licenses are fully backward compatible and do not introduce
any issues into your environment. For more information about upgrading the License Server, see
Upgrade the License Server.

Can a single License Server supply licenses to users connecting from different servers using
different product editions?

Yes. One License Server can contain licenses for multiple editions of a Citrix product. The type of
license checked out corresponds to the edition that is configured on the product server. A product
server is configured to consume a specific edition of a license and checks out that license edition.

For more information and examples, see Single License Server and different servers using different
product editions.

Where is the License Administration Console?

The License Administration Console is not available in License Server 11.16.6 and later. We recom-
mend you
use the Citrix Licensing Manager to manage the License Server.

Disaster recovery and maintenance
How do | license my disaster recovery site?

You can use the same licenses for your disaster recovery that you use for your production environ-
ment.

+ Configure and manage your disaster recovery environment independently of your production
environment.

» Don’t use both the production and backup License Servers to service license checkouts at the
same time.
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+ Make only one License Server accessible at any one time
» The License Server in your disaster recovery environment must have an identical host name to
the License Server in your production environment.

For more information, see Disaster recovery - back up and redundancy.

Citrix licensing technical overview

December 7, 2023

Before you can use your Citrix product, you must install Citrix licensing. Citrix licensing is a system of
components that function together. This system includes:

License Server. A system that allows licenses to be shared across the network.

License files. The files required to license your product. These files are stored on the License
Server.

Citrix Licensing Manager. The recommended License Server management method.

For more information about the following Citrix Licensing Manager features, see Settings:

+ Configure user and group accounts.
+ Short code registration of the License Server to Citrix Cloud and easy removal of registration.
+ Change these ports:

- License Server (default 27000)
- Vendor Daemon (default 7279)
- Web Services for Licensing (default 8083)

+ Check for and install the Customer Success Services renewal.

« Enable and disable the supplemental grace period.

+ Register your License Server with Citrix Cloud.

« Configure historical data retention by selecting a retention period. Default data retention is 180
days.

« Configure Citrix Customer Experience (CEIP) and Call Home at any time.

+ Retry failed citrix.com and Customer Experience Improvement Program uploads.

« Force data uploads to Citrix.

For more information about the following Citrix Licensing Manager features, see Install licenses:

+ Simplified installation of license files on the License Server using a license access code or down-
loaded file.
+ Display details of licenses after they are installed.
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For more information about the following Citrix Licensing Manager features, see Dashboard Dash-
board and Historical Use:

« Dashboard that displaysinstalled, in-use, expired and available licenses, and Customer Success
Services dates.
« Enhanced user/device license usage reporting.

For more information about the following Citrix Licensing Manager feature, see Historical Use in Dash-
board and Historical Use:

« Simplify data export by allowing you to select all products, all license models, and all Customer
Success Services (Subscription Advantage) dates.

Web Services for Licensing. Enables Studio, Director, and the Licensing Administration PowerShell
Snap-in to:

« Communicate with the License Server and manage users.
+ Allocate and install licenses.
« Display License Server health, license usage, and other alert messages.

Citrix License Management Service. Enables management of your license environment through a
license management console within Citrix Insight Services. This service assists with license manage-
ment and support:

+ Allocating new licenses if you are about to exceed your license capacity
+ Rescinding old licenses after an upgrade
+ Managing duplicate licenses in a Disaster Recovery (DR) environment

Product-side settings in your Citrix products that are associated with the License Server.

For more information, see Licensing elements and Services.

Licensing operations overview

Typically, the first time a user connects to a Citrix product, the product requests a license from the
License Server. When the License Server grants a license request, the Citrix product reserves a license
for its use. Reserving licenses for this purpose is known as checking out licenses. When the user logs
off from the product server, the product returns the license to the License Server. This process is
known as checking in licenses. Some Citrix products check out the license when a user connects to
the product. The license remains checked out for a predetermined amount of time.

Each time a Citrix product starts, it opens a connection to the License Server by checking out the
startup license. The startup license is a Citrix system file that enables Citrix products to maintain a
continuous connection to the License Server. The following figure shows that each product forms its
own constant connection to the License Server.
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For example, when a server running Citrix Virtual Desktops requests a license, the product retrieves
the License Server name and port number information from the data store. The product then estab-

lishes a connection to acquire the licenses.

Note

When configuring the product-side setting for the License Server name, do not use localhost.

Though you can use the host name, IP address, or FQDN instead, Citrix recommends that you

use the FQDN.

There are three stages of the license checkout process.

Citrix product

server

=1

LUser devices

1

/ Startup license

License Server

XenDesktop
licenses

NetScaler
Gateway
licenses

A Citrix product goes through a three-step process to check out licenses:

1. Atstartup, a computer running a Citrix product checks out a startup license.

2. Aclient device connects to the product server.
3. The product requests a license from the License Server.

Citrix products, such as Citrix Virtual Desktops, store a replica of the licensing information from the Li-
cense Server, including the number and type of licenses. If a Citrix product server loses its connection
to the License Server, or the License Server does not respond in a timely manner, the product enters
a grace period. During the grace period, the product uses its local record of the licenses to continue

licensing the product. Citrix products update this record every hour.
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Scalability

This section provides guidance to ensure successful License Server usage by examining the impact of
license usage scalability in a Citrix environment. We performed this scalability testing:

Virtual Machine Hardware/Configuration:
Intel Xeon E5-2650 v3 @ 2.30 GHz

4 Virtual CPUs

8 GB RAM

Windows Server 2016

6.5 and earlier Concurrent:

+ 3000 connected Citrix Virtual Apps servers
+ 53,000 concurrent licenses
« 50-60 connections per second

Efforts to scale more than 53,000 licenses result in servers going into a grace period. Also, there are is-
sues with WMI and Imstat. We recommend that you maintain 50,000 or fewer concurrent connections
per License Server.

7.x Concurrent:

« 16 Delivery Controllers
« 70,000 concurrent licenses
+ 50-60 checkouts per second

7.x User/Device:

« 16 Delivery Controllers
« 150,000 user/device licenses
+ 50/60 checkouts per second

CITRIX.exe is a single threaded process. While it’s serving Concurrent connections, the maximum
connection limit is based on the single core processor speed. During peak activity, CITRIX.exe uses
100% of a single core and eventually starts timing out. This usage might cause Citrix products to go
into a grace period or errors in the License Server utilities. After the License Server has processed
backlog connections, it returns to normal. Monitor the CITRIX.exe processor usage to determine if a
faster processor is required. We recommend if you experience issues in high scalability environments,
you deploy more License Servers.

User/Device technology is multi-threaded and scales better than Concurrent. During license optimiza-
tions, you might see that periods were licensing activity takes 100% of a single core. This usage is
normal and doesn’t impact the CITRIX.exe processor usage or functionality. We recommend that you
monitor License Server resource usage and add more License Servers to maintain a properly function-
ing environment.
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Note

Running WMI, Imstat, lmutil, or other inventory actions can negatively impact the License
Server performance. We recommend that you minimize these activities. If you require usage
data, export the data from the Citrix Licensing Manager. For more information, see Historical
Use.

Single License Server and different servers using different product editions

One License Server can contain licenses for multiple editions of a Citrix product. The type of license
checked out corresponds to the edition that is configured on the product server. A product server is
configured to consume a specific edition of a license and checks out that license edition.

For example:
ProductServerA is configured to check out Advanced licenses.
ProductServerB is configured to check out Premium licenses.

LicenseServerl contains both Advanced and Premium licenses.

+ Users who connect to LicenseServerl from ProductServerA check out Advanced licenses only.
After the number of Advanced licenses on LicenseServerl is exceeded, new requests from Prod-
uctServerA users are denied until existing Advanced connection licenses are released.

+ Users who connect to LicenseServerl from ProductServerB check out Premium licenses only.
If the number of Premium licenses on LicenseServerl is exceeded, new requests from Product-
ServerB users are denied until Premium connection licenses are released.

Note

License checkout times mightincrease if many product servers that have many users are contact-
ing the same License Server simultaneously. One License Server can accept only 10,000 inbound
TCP/IP requests at one time. If you are planning to have more than 10,000 Citrix product servers
connecting at the same time, we recommend that you use several License Servers. These prod-

uct servers can include Citrix Virtual Apps and Desktops, Delivery Controllers, and Appliances.

Examples of possible deployments:

Scenario 1: Two sites

« SiteA contains product servers configured for the Advanced edition.
« SiteB contains product servers configured for the Premium edition.
« One License Server (shared).

« Userl, User2, User3, User4...User5000 connect only to SiteA.

» User5001, User5002, User5003...User10000 connect only to SiteB.
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Scenario 2: One site

« The site has two sets of published applications.

+ The site is configured as Citrix Virtual Apps and Desktops Premium concurrent and Delivery
Groups 2 as Citrix Virtual Apps and Desktops user/device

« One License Server (shared).

» Userl, User2, User3, User4...User5000 connect only to the concurrent licenses.

« User5001, User5002, User5003...User10000 connect only to Delivery Group 2 user/device
licenses.

Grace period
Note:
The grace period and supplemental grace period are two different features.
The grace period and supplemental grace period features do not apply when licenses expire.

For more information about the supplemental grace period, see Supplemental grace period.

If product servers lose communication with the License Server, the users and the products are pro-
tected by a grace period. The grace period allows the product servers to continue operations as if
they were still communicating with the License Server. After the Citrix product checks out a startup
license, the product and the License Server exchange heartbeat messages every five minutes. The
heartbeat indicates to each that they are still up and running. If the product and the License Server
don’t send or receive heartbeats, the product lapses into the licensing grace period and licenses itself
through the cached information.

Citrix sets the grace period. It is typically 30 days but can vary depending upon the product. The
Windows Event Log, and other in-product messages, indicate if the product has entered the grace
period, the number of hours remaining in the grace period. If the grace period runs out, the product
stops accepting connections. After communication is re-established between the product and the
License Server, the grace period is reset.

The grace period takes place only if the product has successfully communicated with the License
Server at least once.

Grace period example - two sites, both using the same License Server:

The connection between Site 1 and the License Server goes down causing Site 1 to go into the grace
period, continuing operation and making connections. For concurrent licenses, they can connect up
to the maximum concurrent licenses installed. For user/device licenses, they have unlimited connec-
tions. When Site 1 reestablishes communication with the License Server, connections are reconciled
and no new connections are allowed until they are within normal license limits. Site2 is unaffected
and operates as normal.
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If the License Server goes down, both sites go into the grace period. Each site allows up to the maxi-
mum number of licenses installed. As above, the user/device licenses have no limit.

Limitation

The user name is case sensitive in some localized languages. To log on to the Citrix Licensing Manager,
set the domain-name\username in UPPER CASE if it contains non-ASCII characters.

Licensing elements

December 5, 2023

The License Server comprises several licensing elements:

« Citrix vendor daemon

+ Options configuration file

« License request process

« Citrix Licensing Customer Experience Improvement Program (CEIP), Call Home, and compliance

This diagram shows Citrix products connect to the License Server.
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Citrix vendor daemon

The Citrix vendor daemon (CITRIX), a process that runs on the License Server, grants licenses. The
Citrix vendor daemon tracks the number of licenses that are checked out and which product has them.
Citrix products communicate with the Citrix vendor daemon using TCP/IP. By default, the Citrix vendor
daemon uses TCP/IP port 7279.

Options file

The options file (Citrix.opt) is a License Server configuration file. The Citrix vendor daemon reads this
file every time it restarts or receives a command to reread the file. This configuration file defines li-
censing behavior-the number of licenses a product server can use, the location of the System Logs,
logging levels, and other user-defined customizations. The Customer Experience Improvement Pro-
gram (CEIP) and Call Home configurations are stored in this file.

License request process

When a product requests a license from the License Server, the Citrix vendor daemon determines
whether a license is available for the request.

The license request process has two phases: the product startup phase and the user connection
phase.

Product Start-Up Phase:

« When a Citrix product starts, it retrieves the License Server location from its data store.
+ The product connects to the Citrix vendor daemon.
« The product checks out a startup license.

User connection phase:

« A user connects to a computer running the Citrix product.

+ The product requests a license from the License Server.

+ The Citrix vendor daemon checks to see if any licenses are available and grants or denies the
product’s request.

« Thelicense modulein the product grants or denies the use of the product based on the response
from the Citrix vendor daemon.
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Citrix licensing Customer Experience Improvement Program (CEIP), Call Home, and
compliance usage and analytics programs

The Citrix Licensing CEIP, Call Home, and compliance usage and analytics programs are data collec-
tion programs designed to improve your product experience and gatherimportant license compliance
information.

Citrix handles your data in accordance with the terms of your contract with Citrix, and protects it as
specified in the Citrix Services Security Exhibit available on the Citrix Trust Center.

CEIP and compliance are enabled by default during License Server installation. Call Homeis voluntary.
You can change your participation in the programs at any time by using the Citrix Licensing Manager.
For more information, see “Share usage statistics”under Usage and statistics.

Important

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service
Provider licenses installed, you can change the settings, but you cannot disable CEIP or Call
Home. When the License Server detects Citrix Service Provider licenses, it enforces daily
uploads.

For information about configuring a proxy server, see Configure a proxy server manually in the Get
started article.

For information about command-line installation, see Use the Windows command line to install li-
censing.

Citrix Licensing Customer Experience Improvement Program (CEIP)

The CEIP program gathers configuration and usage data from your Citrix product deployment and
sends the data to Citrix once a day, based on the service start time.

Data Collected Description What We Use It For

License usage and compliance  Information about the Citrix We use this data to track how

data licenses installed on the licenses are consumed and
License Server, including track customer population
product ID, license type, and compliance.

quantity, in addition to license
usage information.
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Data Collected

License Server deployment and

configuration data

Description

Information about the License
Server and how it was
deployed, including license
server version, operating
system version, and
configuration states.

CEIP data elements for build 32000:

License Server
Information

GUID FeaturelD

Feature

SADate

DateSampleStartUTQPE ID

DateSampleStopUTAJDBInFileCreatedUTDateSampleStopUTC

DateSampleStop
PoOrtLACHTTP
PortLACHTTPS
PortLACRedirect
PortLS

PortVD

PortwSL
UDUseDomain
OptFileNoLogStatus
OptFileComplianceConfig
UDUserNameCase
UDDeviceNameCase
SARenewalCheckOption
EncoreSamplingPeriod
EncoreRetentionTime
EncoreEnabled

SLSProxy
SLSProxyWinAutoURL

EventlLog

UDReportGenerationtbithtUsedMax

Active

UDAdminUsersReleakaxknsees

UDAdminDevicesRel€aaeutinstalled

Pool
CountTotal
Devices

Usage Samples
Serial
DateExpiration
Datelssued
VendorStr
Countlinstalled
CountOverdraft
Sample
Timestamp
CountinUse

OverDraft

StartupCounts

What We Use It For

We use this data to inform

further development of Citrix
products and to improve the

customer experience.

Serial
ID
SADate
SN

SerialNumbers
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License Server

Information Feature SADate
SLSProxyWinlE Installed
SLSProxyWinDefault Users
SLSProxySlsConfig

0S

WindowsBuildLabEx
WindowsEditionID
WindowslnstallationType
WindowsProductName
WindowsDomainMember
OSBits

OSLocale

VM

VMIDString
VMHVIDString

InstallUTC
ProductVersion
UpgradeFrom
SetupCluster
SGPClockErrorCode
SGPMaxDays

SupplementalGracePeriod

CEIP data elements for build 31000 and earlier:

GUID WindowsEditionID

StartupCounts

FlexeraVersion

DateSampleStopUTC WindowslnstallationType SGPClockErrorCode

DateSampleStop WindowsProductName

SGPMaxDays

SerialNumbers

Feature ID
UDBinFileCreatedUTC
UDReportGenerationUTC
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PortLACHTTP WindowsDomainMember Services Event Log
PortLACHTTPS OSBits Name SADate
PortLACRedirect OSLocale DisplayName DateSampleStartUTC
PortLS MemPhysMB State DateSampleStopUTC
PortVD CPUIDString StartType CountUsedMax
UDUseDomain VM Path Active
OptFileNoLogStatus VMIDString FirewallProfile Licensees
OptFileComplianceConfig MHVIDString FirewallRule CountTotal
UDUserNameCase CPUCountLogical Profile Countlnstalled
UDDeviceNameCase DiskFreeMB Enabled Pool

PortWsL DiskTotalMB BlockAlllnboundTraffic Usage Samples
SARenewalCheckOption HaslPv4 DefaultinboundAction ~ Sample
EncoreSamplingPeriod HaslPv4_DHCP DefaultOutboundAction Timestamp
EncoreRetentionTime  HasIPv6 FirewallRule CountlnUse
EncoreEnabled HasIPv6_DHCP Name OverDraft
SLSProxy Hardwareld Enabled Installed
SLSProxyWinAutoURL  FQDN Application LPE ID
SLSProxyWinlE PrivacySetting Protocol Count
SLSProxyWinDefault InstallUTC LocalPorts

SLSProxySlsConfig ProductVersion Action

oS UpgradeFrom Direction

WindowsBuildLabEx SetupCluster Inventory

Citrix Call Home

Call Home is voluntary. When you opt in, Call Home performs a periodic collection of system and
product configuration, performance, errors, and more. Thisinformation is transmitted to Citrix Insight
Services once a day, based on the service start time.

You can scramble user names and device information on the License Server before it’s sent to Citrix
for processing. For more information, see Anonymize usernames through the License Server.
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If you want to disable the Call Home Citrix Cloud-registered License Server upload, use the Citrix
Licensing Manager.
tics to either Help improve Citrix products by sending detailed License Server system and
non-identifiable usage information (which does not identify users) to the Citrix Customer

Change your selection under Usage and statistics > Share usage statis-

Experience Improvement Program (CEIP) or Send only basic License Server system and usage
information (which does not identify users) required for license compliance purposes. You’re
still registered with Citrix Cloud, but your Call Home information isn’t sent.

If you want to remove your registration, see Register and remove registration with Citrix Cloud in Usage

and statistics.

Data Collected

License usage and compliance
data

License Server deployment and
configuration data

Description

Information about the Citrix
licenses installed on the
License Server, including
product ID, license type, and
quantity, in addition to license
usage information.

Information about the License
Server and how it was
deployed, including license
server version, operating
system version, and
configuration states.

Call Home data elements for build 32000:

License Server

Information Feature

GUID FeaturelD

SADate

DateSampleStartUTAPE ID

DateSampleStopUTAJDBIinFileCreatedUTDateSampleStopUTC

DateSampleStop
PortLACHTTP EventLog
PortLACHTTPS

PortLACRedirect

PortLS

UDReportGenerationbihtUsedMax

Active

UDAdminUsersReleakaxknsees
UDAdminDevicesRel€asaakinstalled

Pool

StartupCounts

What We Use It For

We use this data to track how
licenses are consumed and
track customer population
compliance. Registering the
License Server with Citrix Cloud
allows you to track your usage
over time in Citrix Cloud.

We use this data to inform
further development of Citrix
products and to improve the
customer experience.

SerialNumbers

Serial
ID
SADate
SN
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License Server

Information Feature

PortVD

CustomerID

OrgID

PortWSL

UDUseDomain
OptFileNoLogStatus
OptFileComplianceConfig
UDUserNameCase
UDDeviceNameCase
SARenewalCheckOption
EncoreSamplingPeriod
EncoreRetentionTime
EncoreEnabled

SLSProxy
SLSProxyWinAutoURL
SLSProxyWinIE
SLSProxyWinDefault
SLSProxySlsConfig

0S

WindowsBuildLabEx
WindowsEditionID
WindowslnstallationType
WindowsProductName
WindowsDomainMember
OSBits

OSLocale

VM

VMIDString

SADate

CountTotal
Users

Devices

Usage Samples
Serial
DateExpiration
Datelssued
VendorStr
CountlInstalled
CountOverdraft
Sample
Timestamp
CountinUse
OverDraft

Installed

StartupCounts

SerialNumbers
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License Server

Information Feature SADate

VMHVIDString
Hardwareld

FQDN
PrivacySetting
InstallUTC
ProductVersion
UpgradeFrom
SetupCluster
SGPClockErrorCode
SGPMaxDays

SupplementalGracePeriod

StartupCounts

Citrix Call Home data elements for build 31000 and earlier:

GUID WindowsEditionID

DateSampleStopUTC

FlexeraVersion

WindowslnstallationType SGPClockErrorCode

DateSampleStop WindowsProductName SGPMaxDays
PortLACHTTP WindowsDomainMember Services
PortLACHTTPS OSBits Name
PortLACRedirect OSLocale DisplayName
PortLS MemPhysMB State

PortvD CPUIDString StartType
UDUseDomain VM Path
OptFileNoLogStatus VMIDString FirewallProfile
OptFileComplianceConfigMHVIDString FirewallRule
UDUserNameCase CPUCountLogical Profile
UDDeviceNameCase DiskFreeMB Enabled

SerialNumbers

Feature ID
UDBinFileCreatedUTC
UDReportGenerationUTC
Event Log

SADate
DateSampleStartUTC
DateSampleStopUTC
CountUsedMax
Active

Licensees

CountTotal
Countlinstalled

Pool
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PortWSL DiskTotalMB BlockAllinboundTraffic  Usage Samples
SARenewalCheckOption HasIPv4 DefaultinboundAction  Sample
EncoreSamplingPeriod HasIPv4_DHCP DefaultOutboundAction Timestamp
EncoreRetentionTime  HasIPv6 FirewallRule CountInUse
EncoreEnabled HasIPv6_DHCP Name OverDraft
SLSProxy Hardwareld Enabled Installed
SLSProxyWinAutoURL  FQDN Application LPE ID
SLSProxyWinlE PrivacySetting Protocol Count
SLSProxyWinDefault InstallUTC LocalPorts

SLSProxySlsConfig ProductVersion Action

0sS UpgradeFrom Direction

WindowsBuildLabEx SetupCluster Inventory

Compliance uploads

Installing the License Server enables the sending of compliance information to the Citrix License Man-
agement Service. Your installation of the License Server constitutes your acknowledgment of the Li-
cense Management Service and your consent to use the License Management Service. You can disable
the License Management Service anytime after installation.

For information about the Citrix License Management Service and how to disable the compliance up-
load, see Citrix License Management Service.

Data Collected Description What We Use It For

License usage and compliance  Information about the Citrix We use this data to confirm

data licenses installed on the customer compliance with
License Server, including license requirements.

product ID, license type, and
quantity, in addition to license
usage information.
License Server system Information about the license We use this data to identify the
information server (such as Hardware ID) License Server in the customer’
s environment.
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Compliance data elements for build 32000:

License Server

Information Feature SADate StartupCounts
GUID Feature ID CountUsedMax LPE ID
Hardwareld UDBinFileCreatedUTC  Serial

InstallUTC UDReportGenerationUTC

UDAdminUsersReleased

UDAdminDevicesReleased

Compliance data elements for build 31000 and earlier:

GUID Feature ID Serial
Hardwareld SADate Startup Counts
Inventory CountUsedMax LPEID
License types

May 30, 2024

Your Citrix product uses one of the license types described in this document. Some products allow
you to select more than one type of license. Ensure that you are aware of the licenses that are pur-
chased and how they are consumed. Some license types offer license overdraft and supplemental
grace period as a feature.

The Citrix License Server supports any Citrix products that require Citrix licenses. For more informa-
tion, see Products and license models.

User/device license
Overview

In user/device type licensing the License Server dynamically assigns a license to a user or a device
based on the usage and monitors license consumption. The default assignment is a user license. The
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license server considers each connection and its optimization engine. It ensures that the smallest
number of licenses are used based on the userID and devicelD.

The license server truncates domains by default so that eng@abc.comand citrite@abc.com
are treated as a same user. For more information, see Disable the domain name truncation.

Note:

Domain membership doesn’t play a role in how licenses are served. A license server can host
licenses for any product that can connect to it across the network. Workgroup or Domain mem-
bership primarily controls who can be configured as License Server Administrators to access the
Citrix Licensing Manager.

Scenarios

+ When alicenseis assigned to a user. A user license allows the user to access from an unlimited
number of devices. A licensed user requires a unique user ID, such as an Active Directory entry.

For example, the user can connect to their desktops and applications using multiple devices such as
desktop, laptop, smartphone, or thin client. A licensed user can connect to multiple instances of Citrix
Virtual Desktops concurrently.

+ When a license is assigned to a device. A device license is assigned to a device when two or
more users connect to an exclusively shared endpoint device.

For example, single shared devices such as a kiosk or a workstation in a call center environment used
by multiple users.

The following table illustrates how user/device licenses are assigned to non-shared devices and exclu-
sively shared devices. Blue color cells display user licenses, where the devices are not shared. Green
color cells display device licenses, where the devices are exclusively shared.
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Devices/Users John Rose @ Joe Roy Tom Karen Rick @ Tony
Laptop X X

PC X

Mobiles X X X X

Laptop?2 X X

PC1 X

Desktop1 X X X X

Desktop?2 X X

License assignment period

When users or devices connect to an application or desktop, they consume a license for a 90 day as-
signment period. The license assignment period begins when a connection is established. The period
is renewed to a full 90 day during the life of the connection. The user/device lease for the license as-
signment will expire in 90 days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
« The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

License optimization

The License Server uses the optimization process to determine how to minimize license consumption.
This optimization is based on licensesin use and connections to the License Server. The License Server
optimizes every five seconds until there are 5000 unique connections. Connections at 5000 and above
optimization occurs every five minutes. Optimization might delay status information until the next
optimization, impacting when license usage statistics are updated in various consoles.

Optimization occurs every five seconds for 1-4999 uses and every five minutes for 5000 or more uses.
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Optimization is not consumption. The following table is the example of connections and optimization
time when optimization occurs.

Device and user connection Optimization time

700 users * 1 device each 700 (optimize every 5 seconds)

5000 users * 1 device each 5000 (optimize every five minutes)

5000 devices * 1 user each 5000 (optimize every five minutes)

2500 users * 2 devices each 5000 (optimize every five minutes)
Note:

+ If you have a large deployment, optimization can be CPU intensive depending on the num-
ber of unique connections. We recommend using machines with multiple cores.

+ Customers hosting many license servers or shared disk systems see high read and write op-
erations. Evenifall the license servers have less than 5000 users, each would optimize every
5 seconds and write cache data to disk. You cannot disable the optimization or change its

frequency.

Concurrent license
Overview

Concurrent license is not tied to a specific userID, Active Directory account, or a domain. Concurrent
licensing is based on the originating endpoint devicelD.

You start a product that requests a license and it is checked out to a unique endpoint devicelD. When
you log off or disconnect from the session, the license is checked in and is available for a new user.

Scenarios

« Multiple sessions at different computers use multiple licenses. Each time you start a Citrix
session from various devices, a license is checked out until you close that session. At that point,
the license is checked back in.

For example, a user starts a session from one computer and then starts another from a different
computer before closing the first session. Two licenses are checked out.

« License Servers do not communicate with each other. If you run multiple License Servers,
you might consume more than one license (for example, with load balancing). If you are using
load balancing, we recommend that the product servers point to the same License Server.
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« Different editions consume different licenses. Two licenses are consumed, if you use the
same client to connect to applications running on an Advanced edition and Premium edition
each.

« Same product, edition, and license model consume single license. If you make multiple
connections from a single device to different product servers configured with same edition and
license model and pointing to the same License Server. Only one license is consumed.

« For license sharing, pass-through connections on Citrix Virtual Apps and Desktops pass
the endpoint client device ID to the product server. If you connect to asingle product, edition,
and license model with a shared License Server, all connections share a single license.

+ A user connects from a single device to two product servers that are the same edition but dif-
ferent versions. One or two licenses might be consumed based on the order in which the user
makes the connections.

For example, the two servers are Citrix Virtual Apps and Desktops 7 1811 and Citrix Virtual Apps
and Desktops 7 1903:

- The user connects to Citrix Virtual Apps and Desktops 7 1811 first. Two licenses might
be consumed. An older license first, for the older product, and then a newer license be-
cause version 1903 requires a newer Customer Success Services date. For more informa-
tion, see Customer Success Services.

- The user connects to Citrix Virtual Apps and Desktops 7 1903 first. Only one license is
consumed because the Customer Success Services date required by version 1903 is com-
patible with all older product versions.

- If the Customer Success Service date of all the installed licenses are compatible with all
the product versions then a single license is required for each connecting device.

« RDP connections consume a license but RDP connections to a console do not consume a license.

« If the number of connections exceed the purchased and available standalone concurrent li-
censes, users are denied access unless the supplemental grace period is enabled. For more
information, see Supplemental grace period.

Per user license
Overview

Alicensed user requires a unique user ID, such as an Active Directory entry. When a license is assigned
to a user, the license allows the user to connect to their desktops and applications using multiple
devices. A User license is assigned to the User and not to the User’s devices.
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Note:

These licenses are only user licenses and are not the same as user/device licenses.

Scenario

« Ausercan connectto multiple devices such as desktop computer, laptop, netbook, smartphone,
or thin client. A licensed user can connect to multiple instances of Citrix Virtual Desktops con-
currently.

License assignment period

When a user connects to multiple devices, a user license is consumed for the 90 day assignment period.
The license assignment period begins when a connection is made. The period is renewed to the full
90 days during the life of the connection. The device lease for the license assignment will expire in 90
days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
« The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

Per device license
Overview

A licensed device requires a unique device ID and any individuals can access instances of a product.
It allows an unlimited number of users per device. A single Device license can support multiple users
from the same device.

Note:

These licenses are only device licenses and are not the same as user/device licenses.
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Scenarios

+ Aclassroom workstation, used by many students.
« Aclinical workstation in a hospital, used by hospital staff.

License assignment period

When asingle device is used by multiple users, a device license is consumed for the 90 day assignment
period. The license assignment period begins when a connection is made. The device lease for the
license assignment will expire in 90 days after the last connected user or device disconnects.

Release licenses for users or devices

You can release a license for a user only when:

« The employee is no longer associated with the company.
« The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.

For more information, see Display or release licenses for users or devices.

Per socket license

Per socket licenses are consumed based on the number of CPU sockets. Cores are not counted. For
example:

« If a computer with two CPU sockets has only one CPU then only one license is consumed.
« If a computer with two sockets has two CPUs, each with a quad core, then two licenses are used.

Citrix Hypervisor uses per socket licenses.

Named user license (legacy)

In a product when you request a license, a named user license is checked out until a preconfigured
period expires. This type of license check-out is not tied to a computer or a device. After the license
is checked out, the user can run multiple sessions on different computers without checking out more
licenses.
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License overdraft

On-premises products that support user/device, user, or device license models include a license over-
draft feature. This feature enables you to use an additional 10% of extra licenses beyond the pur-
chased quantity to prevent access denial. The license overdraft count is displayed in a separate col-
umn within the License Administration Console. The installed column displays both the purchased
license total plus the associated overdraft total. Overdraft usage is also visible in Studio.

The license overdraft feature is offered as a convenience, not as a license entitlement. Any overdraft
licenses used must be purchased within 30 days of first use.

Concurrent licenses and server licenses do not contain the overdraft feature. Citrix reserves the right
to remove any overdraft feature in new product releases.

Supplemental grace period

The supplemental grace period enables unlimited connections to a product for 15 consecutive days.
This feature is available to Citrix Virtual Apps and Desktops licenses. You can use this feature with a
XenApp 7.6 or XenDesktop 7.6 version and above.

If all licenses are in use, including the license overdraft where applicable, the supplemental grace
period gives you time to determine why you exceeded the maximum license count and to purchase
more licenses without disrupting your users.

After the supplemental grace period expires, normal connection limits are enforced. Users are not
disconnected during active sessions. As they disconnect, however, no new connections can occur
until the license levels return to normal.

The supplemental grace period is not automatically re-enabled once it completes. To re-enable the
supplemental grace period, you must install another retail license, which grants a new 15-day supple-
mental grace period if and when you exceed the subsequent maximum installed licenses limit.

We recommend that you allow the supplemental grace period to run out after it starts. To clear the
warning condition do not add licenses immediately. Doing so gives you time to fully assess the situa-
tion and correctly address any issues.

Note:

If you install licenses while the supplemental grace period is in force, the License Server exits the
supplemental grace period. Reenabling the supplemental grace period before fully determining
the reason for the supplemental grace period, and how many licenses you require, might cause
you to reenter the period after installing new licenses.

Supplemental grace periods are granted per product version and edition and only for retail li-
censes. The supplemental grace period is enabled by default when you first install the licenses. To
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disable the supplemental grace period feature, use the Citrix Licensing Manager.

Thereis nowayto track the total number of licenses consumed while in the supplemental grace period.
You canuse Lmstat udadminand connectioninformation from the product to determine how many

additional licenses are required.
Note:
The grace period and supplemental grace period are two different features.
The grace period and supplemental grace period features do not apply when licenses expire.

For more information about grace periods, see Grace period.

Citrix Virtual Apps and Desktops Director displays the grace period states. For more information, see

Panels on the Director Dashboard.

The supplemental grace period feature is offered as a convenience, not as a license entitlement. Citrix
reserves the right to remove any such feature in new product releases.

Overdraft and Supplemental grace period examples

Example 1: Citrix Virtual Apps and Desktops user/device, user, or device licenses using the overdraft

and supplemental grace period features

1000 1 @ 1000 <11 @ 1000 . 1000 1

v g

do dio d25

SGP

~
r

Time

You initially purchase and install 1000 licenses from Citrix (I) which includes a 10% license overdraft al-
lowance (OD). When licenses are allocated, you’ll have 1100 licenses in total. At the time it is sufficient

for the number of users connecting.

do At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the overdraft
feature was activated. Your users can continue to connect without any disruption of service. You start
evaluating your licensing needs now. Do not wait until you exceed the OD. Think about buying more
licenses in addition to the 1000 you bought initially.

d10 10 days later (day 10) more users connect and 1150 licenses are being used, which exceeds the
1100 total licenses you have available (!). When the 1101st license was used, the 15 day supplemental
grace period (SPG) started, to allow you time to evaluate your license needs. Your users can continue
to connect without any disruption of service.
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d25 15 days later after d10 (day 25) the supplemental grace period runs out because you chose not
to purchase and install more licenses. Users cannot make new connections if doing so requires more
than 1100 licenses to be checked out. You cannot re-enable the supplemental grace period until you
purchase and install more licenses.

Example 2: Citrix Virtual Apps and Desktops concurrent licenses using supplemental grace period
feature

SGP

do d15 Time
You initially purchase and install 1000 concurrent licenses (I). There is no overdraft allowance with
concurrent licenses. At the time these licenses are sufficient for the number of users connecting.

do At a later date (day 0) you are using 1050 licenses. When the 1001st license was used, the 15 day
supplemental grace period (SPG) started, to allow you time to evaluate your license needs. Your users
can continue to connect without any disruption of service. You start evaluating your licensing needs
now. Do not wait until the supplemental grace period runs out. Think about buying more licenses in
addition to the 1000 you bought initially.

d15 15 days later (day 15) the supplemental grace period runs out because you chose not to purchase
and install more licenses. Users cannot make new connections if doing so requires more than 1000
licenses to be checked out. You cannot re-enable the supplemental grace period until you purchase
and install more licenses.

Overdraft and supplemental grace period availability

The following table lists the support for license overdraft and supplemental grace period for each prod-
uct. For more information, see Products and license models.

Supplemental Grace

On-premises product License type 10% Overdraft Period (15 days)
Citrix Virtual Appsand  User/device, User, Yes Yes

Desktops Device

Citrix Virtual Appsand  Concurrent No Yes

Desktops

XenMobile Server User, Device Yes No
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Citrix on-premises subscription for annual and term-based retail licenses

On-premises subscription licensing allows customers to host a Citrix environment within their infra-
structure for a set period. The on-premises subscription license is time bound for 1-5 years and ex-
pires on a specific date. The license ceases to operate following the expiration date. The products
offer everything that is available today with perpetual conversions.

Your purchase includes both an on-premises subscription license and Customer Success Services Se-
lect service. Customer Success Select service is included for the entire term of the subscription.

Note:

Mixing permanent (perpetual) and subscription licenses is supported. They can be used to
expand existing environments provided customers use the same product, edition, and license
model. There are no performance impacts to using perpetual vs. subscription licenses. The
only difference between them is one expires.

Before license expiration

Citrix notifies you at certain intervals when your existing subscription approaches expiration. These
notifications alert you to extend the subscription and avoid service interruption.

When your on-premises subscription expires, as per the date listed in the Citrix Licensing Manager, no
new connections are allowed. Existing users are not impacted, however, if users log off or disconnect
they are not allowed to reconnect.

Extend on-premises subscription licenses

To extend your on-premises license subscriptions, visit https://www.citrix.com/buy/.
Note:

Licenses with a future start date are not displayed in the License Server inventory until the actual

start date mentioned in the license file.

FAQs
« Will on-premises subscription licenses work with existing perpetual licenses on the same
server?

Yes, within the guidelines of existing license server operation. Customers must add a new term
license file to the license server.
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Term or subscription licensing does not have a negative impact on delivering the on-premises
subscription licenses to a customer’s existing environment, provided the product version
(Virtual Apps / Virtual Apps and Desktops), edition (Standard, Advanced, Premium), and type
(User/Device, Concurrent) are the same. For example:

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium Concurrent term will have no issues.

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Premium User/Device term. This license combination is non-standard and requires con-
sideration and additional configuration. This combination may not be optimal for license
utilization.

- Virtual Apps and Desktops Premium Concurrent perpetual + Virtual Apps and Desktops
Advanced User/Device term. This license combination is non-standard and not advisable.
Requires customer to have multiple sites or farms to use all purchased licenses.

« Will the XenApp farm, Citrix Virtual Apps, Citrix Virtual Apps & Desktops stop accepting
connections?

Yes. No new connections are allowed after the license expires. Existing connections would not
be impacted until users disconnect, logoff, or reset.

« Will there be a supplemental grace period (SGP) of 15 days or does that only apply to per-
petual licenses?

No. There is no grace period for license expiration. An extra month is added into the expiration
date for customers to install repurchased licenses.

License files

October 7, 2023
Before you start installing product licenses, see the prerequisites to obtain your license files.

When you install the License Server, a Citrix start-up license (citrix_startup.lic) and an options file (CIT-
RIX.opt) are installed by default. To license your Citrix products, you add one or more license files. For
information about adding your product licenses, see Install licenses.

You cannot change the location of license files on the License Server. License files must reside in their
default location.
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Citrix Start-up license

The start-up license file (citrix_startup.lic) is a text file that Citrix products use to communicate to
the License Server using a continuous open connection. Every five minutes the License Server and
the product send a heartbeat message to each other to verify that they are mutually communicating.
When the product and License Server exchange heartbeat messages and there is an interruption in
the exchange, the product goes into a grace period. A power failure is an example of an interruption.
The startup license file does not affect your license count.

Citrix License Server Diagnostics License

The License Server uses Citrix License Server Diagnostics License for internal diagnostics and alert
message notifications displayed in Citrix Studio and Director. Itis available by default with the startup
licenseinthe citrix\\_startup.licfile.

Warning

Do not edit the startup license file, or any other license files.

License file

The license file is a text file containing the following:

+ Product licensing information

+ License Server name (or other binding identifier)

« Customer Success Services membership renewal date (also known as the Customer Success
Services expiration date)

« License expiration date (if applicable)

 Other system information

All this information is encrypted using a digital signature. When you purchase a Citrix product, go to
the citrix.comwebsite to download a license file. For more information, see Manage licenses on
Citrix.com. You can have more than one license file per License Server. The license file resides in these
directories, where the License Server references it.

+ C:\Program Files\Citrix\Licensing\MyFiles directory on a 32-bit server
« C:\Program Files(x86)\Citrix\Licensing\MyFiles directory on a 64-bit server

The License Server uses this file to determine whether to grant a license to a Citrix product.

A license overdraft is included in all user/device, per user, and per device licenses. For more informa-
tion on the license overdraft, see License overdraft.
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Move licenses to a different host

The license file you downloaded for the old License Server cannot be moved to a server that has a dif-
ferent host name or MAC address. Create license files that reference the new server name by returning
them and then allocating them.

For more information, see Modify licenses.

License file format
Important

Any changes to the license file can make license files unusable. If using Citrix Licensing for Win-
dows 11.6.1 or later, editing license files is not necessary. You can manage licenses through the
Citrix Licensing Manager and the My Account site at citrix.com. For more information, see
Manage licenses in MyAccount on citrix.com.

You can change the name of the license file, but it must have a .lic (lower case) extension.
Citrix license files use the following naming convention:

FID_fulfillmentID.lic

For example: FID_30d0000_0000_xxxx_c800_00xxyy000zz7.lic

License files are composed of lines listing specific information, such as the server name (SERVER) or
quantity of licenses (INCREMENT). These lines begin by using words denoting their purpose in upper-
case letters, such as VENDOR, SERVER, INCREMENT, USE_SERVER.

The following sections provide in-depth information about the following elements of license file syn-
tax: the SERVER line, VENDOR line, USE_SERVER line, and INCREMENT line.

The following image is an example license file:

SERVER line shows an identifier required for binding licenses to the License Server.

VENDOR line specifies the Citrix vendor daemon name.

INCREMENT lines specifies the license required to use a product.

Comments used by the License Server to translate license FEATURES (PRODUCT_EDITION_LICENSEMODEL)
to Citrix product names.

> wn e
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# This file is in UTF-8 format.

# .

SERVER this_host HOSTNAME=license_serverl '\/_1_3'

YEMNDOR CITRIX .\fz\.. )

USE_SERVER -

INCREMENT MPS_ENT_CCU CITRIX 2006.0428 01-may-2008 1000\ .\”3 )
VENDOR_STRING=;LT=Retail. GP=720;CL=ENT ADY,STD;SA=0;0DP=0% | —
DUP_GROUP=Y ISSUED=12-Mar-2004 NOTICE="eMail Test - Citrix" \
SN=LA-0000150712-86261:872 START=11-mar-2004 SIGN="0885 F320 %
OAE2 EET2 B8A4 92FC B6C2 3648 A2CF 346D ASBF BD44 TS1114
D790 1830 7535 553C B774 DESC 1F5D A5D3 D5FE D078 2178 BHOS0 A

A14C 2893 7756 ACF5"
# g
#English] (4)
H#CITRIXKTERM FEATURE 20 MPS_STD_CCU  EN Citrix Presentation Server Standard|Concurrent User
#HCITRIXTERM FEATURE 20 MPS_ADY_CCU  EN Citrix Presentation Server Advanced|Concurrent User
#CITRIXTERM FEATURE 20 MPS_ENT CCU EN Citrix Presentation Server Enterprise|Concurrent User
#
SERVER Line

The SERVER line specifies the binding identifier (also known as the host name) of the License Server.
Caution:

Do not change the binding identifier on the SERVER line otherwise, the license file doesn’t work.

Syntax:
SERVER this_host ether
Or

SERVER this_host HOSTNAME=hostname

Parameters Description

ether The MAC address of the appliance on which the
License Server is running. Do not edit this text
string.

hostname The name of the computer on which the License

Server is running. Do not edit this text string.

Example

SERVER this_host HOSTNAME=1l1icense_serverl

VENDOR Line

The VENDOR line specifies the Citrix vendor daemon name.
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Syntax:

VENDOR CITRIX [vendor_daemon_path]

Field Description

VENDOR CITRIX Name of the Citrix vendor daemon. Do not edit
this name.

vendor_daemon_path Path to the executable for the Citrix vendor

daemon. Citrix recommends that you do not
change this path.

INCREMENT Lines

An INCREMENT line describes the license required to use a product. License files (*.lic) contain one or
more INCREMENT lines. Each INCREMENT line makes up a user-specified allocation of product and
license (users, connections) counts.

Each increment line contains:

+ Asignature based on the data in that line
+ The hostids specified in one or more SERVER lines
« Data selected by Citrix

INCREMENT lines use a backslash () to wrap long lines of text.
Syntax:

INCREMENT feature vendor css_expiry_date exp_date num_lic
SIGN=sign [optional_attributes]

Caution:

Do not change the six fields after the INCREMENT line keyword. The fields are required and have
a fixed order.

The following table explains these fields in the order they appear:

Field Description
feature The product license. Do not edit this line.
vendor Indicates that this license is for a Citrix vendor

daemon. Do not edit this line.
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Field

CSS_expiry_date
exp_date

num_lic

SIGN=sign

SUPERSEDE_SIGN=sign

Description

Indicates the date until which you are entitled to
product version upgrades. If you don’t have a
Customer Success Services membership, or this
license isn’t a Customer Success Services license,
the date indicates when you ordered or
redeemed the license. Do not edit this line.
Note: If you renewed your Customer Success
Services membership and received an upgrade
license, the CSS_expiry_date is listed. For
example: INCREMENT MPS_ENT_CCU CITRIX
2019.0311 permanent 1000

Expiration date of license in the format
dd-mmm-yyyy, that is, 07-may-2006. Do not edit
this line. Note: If the exp_date field contains the
text string permanent, the license never expires.

Number of concurrent licenses for this product

license. Do not edit this line.
SIGN=signature to authenticate this INCREMENT

line. Do not edit this line.
Strategically turns off specific licenses based on

license feature and signature or INCREMENT line
to be disabled. Customer Success Services or
maintenance upgrade licenses include
SUPERSEDE_SIGN. Example:
SUPERSEDE_SIGN={“CBR_100_SSERVER:0F76
2946 4790 6B67 08E0 65BC 302B E1B6 6ECE 41D6
8AB6 E9C6 FE44 4EB3 9A83 01E4 D405 3E95 74B8
9BC8 7791 BDD3 1385 33F8 9533 95FF A3E4 F461
35B4 251E}

INCREMENT lines also determine the grouping of licenses in the management console. These groups

are known as license pools. The Citrix vendor daemon creates the license pools based on common

attributes, such as product license or version. The console displays and tracks a newly created pool

independently from other license pools. The Citrix vendor daemon creates a license pool when two

or more attributes are different.

Citrix Attributes in INCREMENT Lines:
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INCREMENT lines can also include more attributes from Citrix. These attributes provide information
about the license, such as the date of issue or if the license is an upgrade license.

Caution:

Do not change or remove these attributes.

Example:

INCREMENT rP5_ENT_CCU CITRIX 2008.0606 permanent 10 Y,
WVENDOR_STRING=;LT=Retail;GP=720;CL=ENT,ADV,5TD,AST;SA=1;0DP=0"% DUP_GROUP=V
ISSUED=06-Jun-2007 NOTICE="Citrix"\ SN=12345:67890 5TART=6-jun-2007 SIGM="18FB 1546
Fo05 E3BD 010E 7E4F A4B3 9DE3 BOOE 7937 3337 0180 1FFB CoAER D491”

Important items are highlighted in the preceding example:

» The Product (license feature) appears in blue
» The Customer Success Services expiration date appears in red (Format: YYYY.MMDD)
« The License (user, connection) count appears in GREEN

Syntax:
keyword=value

The following table describes the Citrix attributes. The uppercase letters of the attributes indicate that
this attribute is not editable.

Attribute Description

DUP_GROUP=V This attribute allows license sharing for the same
client device.

ISSUED=dd-mmm-yyyy Date issued.

ISSUER="...” Issuer of the license.

NOTICE="...” Your company name.

SN=serial_num Serial number is the License Access Code and

the fulfillment ID of that license.
START=dd-mmm-yyyy The date from which you can start using a

license. The License Server cannot use licenses
before their start date. You can install licenses
before the START date but there are not visible in
your License Server inventory until the actual
START date.
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Attribute Description

SUPERSEDE="MPS_ADV_CCU MPS_STD_CCU ...” This attribute appears in the upgrade license file
when you move to a higher product edition. If
this attribute appears, this line supersedes all
licenses issued before the date specified in
ISSUED=and they become ineffective.

VENDOR_STRING="...” Text string defined by Citrix.

Example of a base license:

INCREMENT CBR\_100\_SSERVER CITRIX 2016.1201 permanent 10 \\

VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=1;MLC=0;HA=0;CL=BRSE ;SA=1;0DP
=0 \\

DUP\_GROUP=V ISSUED=18-dec-2005 NOTICE="Citrix" \\

SN=100se200seB SIGN="1B19 C213 7517 CC62 756F 864C 9C93 O6FC \\

E1DE B5D5 D793"
<!--NeedCopy-->

Example of a Customer Success Services renewal license containing SUPERSEDE_SIGN:
INCREMENT CBR\_100\_SSERVER CITRIX 2017.1201 permanent 10 \\

VENDOR\_STRING=;LT=Retail;GP=720;MAXBW=2;MLC=0;HA=0;CL=BRSE;SA=1;0DP
=0 \\

DUP\_GROUP=V ISSUED=18-dec-2007 NOTICE="Citrix" \\

SN=100se200seU SUPERSEDE\_SIGN={
"CBR\_100\_SSERVER:1B19 C213 7517 \\

CC62 756F 864C 9C93 06FC E1DE B5D5 D793" }
SIGN="1D5D 869A 40BE \\

D4DB 361D 7897 AFA5 FF8B E52A 20BA 5525 01AA F241 6919
<!--NeedCopy-->

Licensing services

October 7, 2023
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This article contains the following information:

+ Web Services for Licensing

« Citrix License Management Service

« Citrix Licensing

« Citrix licensing Windows Management Instrumentation (WMI)

Web Services for Licensing

Studio, Director, and the Licensing Administration PowerShell Snap-in use Web Services for Licensing
to do the following:

« Communicate with the License Server and manage users
+ Allocate and install licenses
« Display License Server health, license usage, and other alert messages.

The Citrix Licensing Manager also uses it.

Citrix License Management Service

The License Management Service enables better capacity planning and license management. This
service also helps you avoid prohibited practices:

« Duplication of licenses outside a Disaster Recovery (DR) environment
+ Use of legacy licenses for new product versions
+ Use of rescinded licenses

This service alerts the administrator in Citrix Insight Services about duplicate licenses in a Disaster
Recovery (DR) environment. For more information about Citrix Insight Services, see Citrix Insight Ser-
vices.

The License Management Service uses product telemetry, built into the License Server, to send data
to Citrix Insight Services. The License Management Service is not a Windows service. The first upload
occurs approximately five minutes after the License Server first starts, or restarts, and subsequent up-
loads occur once a day thereafter. The schedule resets if you reinstall the License Server. If an upload
fails, another attempt is made in 24 hours until either the upload succeeds or you disable the License
Management Service. Citrix might use uploads to help you understand and support your license envi-
ronment. See Using the command line to disable or enable the License Management Service.

Important

Your installation of the License Server constitutes your acknowledgment of the License Manage-
ment Service and your consent to use the License Management Service. You can disable the
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License Management Service anytime after installation.

The License Management Service collects this information:

« License serial numbers
 License Server GUID

+ Licenses used count

« Feature name

» Product versions

For more information about the data collected, see Compliance uploads.

Citrix Licensing

The Citrix Licensing service is the Windows service responsible for core licensing functionality. Cit-
rix Licensing services licenses to Citrix products and is responsible for managing the CITRIX vendor
daemon, license server port 27000 (by default).

Citrix Licensing WMI

The WMl service provides access to Citrix Licensing WMI classes. There’s a namespace (ROOT\CitrixLicensing)
with a few classes (notably, Citrix_GT_License_Pool) that gives license usage and availability counts.
Querying the License Server too often (more than every 15 minutes) might impact performance
negatively.

Customer Success Services

October 7, 2023

Your purchase of a new Citrix product includes a one-year membership in Customer Success Services.
This membership entitles you to all product updates, along with other benefits. These updates in-
clude all releases during your membership period.

After your initial one-year membership period expires, renew your Customer Success Services mem-
bership by paying Citrix for your renewal. Use the Citrix Licensing Manager to install your renewal
licenses. You can go to citrix.com and download a license file that has your renewal license.

Important:

A Customer Success Services membership and its license are distinct from your license to run
the product. Your Citrix products don’t stop working if you don’t renew your Customer Success
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Services membership. But you are not entitled to any software releases after it expires.

Customer Success Services renewal licenses

Customer Success Services renewal license files contain licenses, known as renewal licenses, that ex-
tend your Customer Success Services membership for a one-year period. These licenses are required
to run all new product releases, excluding hotfixes, that are released during your membership pe-
riod.

If you do not add the Customer Success Services renewal licenses immediately, your Citrix products
do not stop working. However, you cannot run any new software released during your renewed mem-
bership until you have the renewal license on your License Server.

If Citrix releases a product version after your Customer Success Service membership ends, renew your
Customer Success Services membership. Obtain a renewal license before you can use the new product
version.

Example:

Before you upgrade to any of the Citrix Virtual Apps and Desktops releases, ensure that your current
Customer Success Services dates are valid and have not expired. Citrix Virtual Apps and Desktops
releases use a year-month date format (YYMM). Ensure that the date in your license is equal or newer
than the product release date. For a comprehensive list of release dates, see Citrix Product Customer

Success Services Eligibility Dates.

When you renew your Customer Success Services membership, you can use the renewal license fea-
tures of the Citrix Licensing Manager. For more information see, Update licenses.

Note:

When you download more license files, you can delete the expired Customer Success Services
licenses. However, it is not a requirement. You might want to keep them to make it easier to
identify the upgrade that is associated with each base license.

Find out your Customer Success Services dates by using Citrix Licensing Manager, or view the license
file in the text editor.

Check for and install Customer Success Services renewal licenses with the Citrix
Licensing Manager

When enabled, the Citrix Licensing Manager contacts Citrix.com web services weekly to check for avail-
able Customer Success Services renewal licenses.
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Based on your configuration, the Citrix Licensing Manager automatically checks for Customer Success
Services renewal licenses, or allows you to check manually. It notifies you or installs the licenses when
found.

1. Inthe Citrix Licensing Manager, click Settings in the upper right of the Ul.
2. Choose how you want to be notified and if you want renewal licenses to be automatically in-
stalled.

If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting
or configure a proxy. For this feature to work, the License Server must be able to access https://citrix
services.citrix.com. For more information, see How to configure a proxy server manually.

Note:
You can also configure the ports, the supplemental grace period, and the language on this page.

« Automatically check for Customer Success Services renewal licenses and notify when
available: Citrix Licensing Manager displays a notification. Click the link to download and
install the available renewals. This same notification appears in Studio and Director if they are
configured to manage the License Server.

« Automatically check for and install Customer Success Services renewal licenses when
available: Citrix Licensing Manager checks weekly and automatically installs renewal licenses
when available. A notification displays for a few days stating that renewals have been installed.

« Manually check for Customer Success Services renewal licenses: Select the Update
Licenses tab and Check for Available Renewals. You can check the Update Licenses tab at
any time to see a list of licenses installed in the last 30 days.

Get started, install, and configure the License Server

December 7, 2023

Important:

+ We do not support running third party vendor daemons on the Citrix License Server, or the
Citrix vendor daemon on third party license servers.

+ We recommend that you run the latest version of the License Server. We do not provide hot-
fixes for License Server components and don’t support older License Servers with newer
products. The latest version of the License Server often contains resolutions to issues ap-
pearing in earlier versions. When you upgrade or install new Citrix products, upgrade the
licensing components as well. New License Servers are backward compatible and support
older products and license files. However, new products often require the newest License
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Server to check out licenses correctly. You can find the latest version from the Citrix Down-

loads site.
To see the new features in this release, go to What’s new.

« We don’t support installing the License Server from a UNC path (\\\\server\share).
Install the License Server from a local copy.

Step 1 Review your prerequisites

Before you begin to install and configure your License Server, review the system requirements.

Step 2 License your product

Licensing your product includes the following steps:

Ensure that you have the latest License Server version.

Verify the system requirements.

Install licensing.

Obtain license files from My Account or if you have a license code, use the Citrix Licensing Man-

> wnN e

ager.

5. Install your Citrix product (or, if already installed, restart the Citrix products for the new licenses
to be recognized).

6. Configure product-side licensing communication settings that were not set during the product
installation, if applicable. This configuration includes setting the correct product-edition in the
product. For more information, see Licensing elements and Services.

Ensure that the product-side edition setting correctly matches the licenses you have purchased. For
example, if you purchased Premium edition licenses, ensure that the edition setting in the product
indicates Premium and not Advanced.

For an overview of the licensing components and process, see Technical overview and Licensing ele-

ments.

Important:

The License Server does not require domain membership. You can install the License Server in
a workgroup and still perform all licensing functions on behalf of Citrix products. To manage
Citrix Licensing Manager users having Active Directory users or groups, the users must be part of
a domain. Otherwise, use local Windows users and groups.
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Step 3 Check your security and firewall
Security considerations

We recommend that you upgrade the License Server to the latest version when you upgrade or install
new Citrix products. The new License Servers are backward compatible and support older products
and license files. Each time a new License Server is released, it might contain better security features
than in previous versions. We also recommend the following security considerations when you con-
figure your environment.

+ Configure the License Server environment so that only authorized administrators on a trusted
network can access the Citrix Licensing Manager port. You achieve this outcome by using an
appropriately configured network or host-based firewall.

» Whenusing the Citrix Licensing Manager, avoid visiting untrusted websites or clicking untrusted
URLs.

Firewall considerations

Determine if you require a firewall between the License Server and any product servers before in-
stalling licensing. Firewall considerations can impact where you install the License Server.

If you have hardware firewalls in your environment, you must create the necessary rules manually.

If there is a firewall between your product and the License Server, configure port numbers. This con-
figuration process entails:

+ Determining which port numbers to change. You can change port numbers during the instal-
lation process or afterward.

+ Opening up the firewall ports. Open any ports on the firewall that you changed so that traffic
can flow. Current releases configure the built-in firewall automatically.

+ Changing the product-side settings. Configure your Citrix product to use the same port num-
bers as in the Citrix Licensing Manager. If you do not change the port number referenced in
the product, the product cannot contact the License Server. You can change the product-side
settings during and after installation of the product. See your product documentation for infor-
mation about these settings.

For more information about allowing registered URLs and ports through the firewall and a list of open
URLs, see Register and remove registration with Citrix Cloud.

Step 4 Install licensing components, server, and certificate

During installation, localized characters in the installation path can cause the installation to fail. Ac-
cept the default installation path or type only ASCII alphabetic letter characters for the installation
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directory.

Step 4A Install licensing components

You can install licensing components on a separate, dedicated server or on a server they share with
another application. Alternatively, you can use a web or application server. However, the locations
mentioned later in this article are less resource intensive. If you are running fewer than 50 servers or
10,000 licenses, you can install the License Server on the same server as your product. To determine
if relocation of the License Server to another system is necessary, monitor CPU and memory load
(lmgrd.exe and CITRIX.exe).

Important:

Usethe CitrixLicensing.exe fileforall future installations, except for Active Directory de-
ployments. In that case, use the .msi. Ensure that both . exe and .ms1i files are present for the
installation.

Step 4B Install the License Server and console using the graphical interface

1. Download the License Server from Citrix downloads and start the License Server installer,
CitrixLicensing.exe,asanadministrator or a member of the administrators group.

2. Follow the installer on the GUI to accept the destination folder.
Licensing components are installed in C:\Program Files\Citrix\Licensing on
a 32-bit computer and C:\Program Files (x86)\Citrix\Licensing on a 64-bit
computer.

3. On the Configure page, accept, or change the default port numbers used by licensing com-
ponents. Choose whether to allow the installer to configure the Windows Firewall exception.
If needed, you can change the port numbers after the installation. If you choose to finish the
installation without configuring the License Server, restart the CitrixLicensing.exe
installer. You can also use the License Server Configuration tool to configure the settings after
the installation.
Open the configuration tool from: C:\Program Files\Citrix\Licensing\LS\
resource\Licensing.Configuration.Tool.exe.

+ License Server port number is 27000
« Vendor daemon port number is 7279
+ Web Services for Licensing port number is 8083

4. The License Server adds the default administrator for the Citrix Licensing Manager based on
how you are logged on. If you are in a domain, the License Server adds the installing user (do-
main\user) as a default License Server or a Citrix Licensing Manager administrator. If you are a
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local Windows user, the License Server adds the installing user (computer\user) as a default ad-
ministrator account. The BUILTIN\administrator group, which allows any administrator to man-
age licensing, is added by default. You can remove BUILTIN\administrators to restrict licensing
to specified users.

5. Choose to start the Citrix Licensing Manager and whether to join the Citrix Customer Experience
Improvement Program.

Step 4C Install licensing using the Windows command line

Important:

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP)
and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

When using the CitrixLicensing.exe command to install licensing, set properties by adding
Property=value onthe command line anywhere except between an option and its argument.

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right-click Command Prompt, and choose Run as adminis-
trator.

The following sample command line installs licensing in silent mode. Add the properties you want to
set.

Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

CitrixLicensing.exe /quiet /1l install.log INSTALLDIR=1installdirectory
WSLPORT=port_number LSPORT=port_number VDPORT=*port_number CEIPOPTIN
=value

Where:

+ [quiet specifies a silent (quiet) installation.
+ [Uspecifies the log file location

« INSTALLDIR is the location where the License Server executable is stored. Optional parame-
ter. The defaultis c:\program files\citrix\licensingorc:\program files
(x86)\citrix\licensing.

« WSLPORT is the port number used for the Web Services for Licensing. Optional parameter. The
default is 8083.

« LSPORT is the port number used for the License Server. Optional parameter. The default is
27000.
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« VDPORT is the port number used for the vendor daemon. Optional parameter. The default is
7279.

« CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is ANON.

- DIAG-Call Home
- ANON - CEIP
- NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to install licensing for an Active Directory deployment

When using the msiexec command to install licensing, set properties by adding Property="value”on
the command line anywhere except between an option and its argument. Clustering is not supported
in the .msi.

Note:

Ensure that you run the command line with administrator privileges. To start the command
prompt with elevated privileges, choose Start, right-click Command Prompt, and choose Run
as administrator.

The following sample command line installs licensing in silent mode and creates a log file to capture
any information about this operation. Add the properties you want to set after the switches.

Type the command in one line without returns. The following example is in multiple lines because of
space limitations.

msiexec /I ctx_licensing.msi /1l*xv install.log /gn INSTALLDIR=1installdirectory
LICSERVERPORT=port_number VENDORDAEMONPORT=port_number MNGMTCONSOLEWEBPORT
=port_number WEBSERVICESLICENSINGPORT=port_number CEIPOPTIN=value

Where:

+ /I*visthe location of the setup log. Optional parameter.
« /gn specifies a silent (quiet) installation.

« INSTALLDIR is the location where the License Server executable is stored. Optional parame-
ter. The defaultis c:\program files\citrix\licensingorc:\program files
(x86)\citrix\licensing.

+ LICSERVERPORT is the port number used for the License Server. Optional parameter. The de-
fault is 27000.
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+ VENDORDAEMONPORT is the port number used for the vendor daemon. Optional parameter.
The default is 7279.

+ WEBSERVICESLICENSINGPORT is the port number used for the Citrix Licensing Manager. Op-
tional parameter. The default is 8083.

« CEIPOPTIN specifies whether, or how, to opt in to the Citrix Customer Experience Improvement
Program (CEIP) or Call Home. Optional parameter. The default is ANON.

- DIAG - Call Home
- ANON - CEIP
- NONE

You can change the CEIP and Call Home choice using the Citrix Licensing Manager.

Using the command line to disable or enable the License Management Service

The License Management Service operates automatically within the License Server and allows for li-
cense management and support. We recommend using the License Management Service for manage-
ment of your license environment, but you can disable it anytime after installation. For more informa-
tion, see Citrix License Management Service in Technical overview.

Syntax:
ctx_license_management_service.exe (-enable | -disable | -query)

Where:
+ -enable enables license management. The first upload to Citrix occurs seven days after you
install the License Server.
+ -disable disables license management. We recommend that you use the License Management

Service to manage your licensing environment.
«+ -query displays the current configuration.

Step 4D Manually install a certificate used by the Citrix Licensing Manager and Web
Services for Licensing

Note:

Use this procedure if you don’t want to use the self-signed certificate that is generated during
installation.

To install a certificate, there are three steps:

1. Obtain a.pfxfile, which contains the certificate and private key. You can use one of two methods
to obtain the .pfx file.
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2.
3.

Extract the certificate and private key from the .pfx file.
Install the certificate and private key on to the License Server.

Method 1 - How to obtain the .pfx file using a domain certificate

Log on to a server in the domain, open the MMC, and follow these steps:

1. Create a directory c:\ls_cert to hold the exported .pfx file.

Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Computer
account > Local computer.

In the left pane under Certificates, right-click Personal and choose All Tasks > Request New
Certificate, and then Next.

In the Certificate Enrollment Policy wizard, choose Active Directory Enrollment Policy, and
then Next. Select the check box next to Computer, and select Details to the right.

5. Select Properties and on the General tab, type a friendly name and description.

6. On the Subject tab, under Subject Type, choose Common name from the Type menu. Type a

10.

11.

12.

13.

friendly name in the text box, choose Add, and then Apply.

On the Extensions tab, choose Key usage from the menu, add Digital signature and Key en-
cipherment to the Selected options box.

On the Extended Key Usage menu, add Server Authentication and Client Authentication to
the Selected options box.

On the Private Key tab and under the Key options menu, ensure that the Key size is 2048. Select
the Key Exportable check box, and then Apply.

On the Certification Authority tab, ensure that the CA check box is selected, and then OK >
Enroll > Finish.

In the Certificates console, select Personal > Certificates, choose the certificate you built. Se-
lect All Tasks > Export > Next, and select the Yes, Export the Private Key radio button, and
then Next.

Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all
certificates, choose Next, create a password, and choose Next.

Click Browse, navigateto C: \ls_certandtype server.PFX, andthen follow the wizard to
finish.

Method 2 - How to obtain the .pfx file sending a request to a certificate authority (CA)

These steps might vary based on your Certificate Authority.

1.

Log on to the License Server, open the MMC, and follow these steps:

a) Add the Certificate snap-in by selecting File > Add/Remove Snap-in > Certificates > Com-
puter account > Local computer.
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b) In the left pane under Certificates, right-click Personal and choose All Tasks > Advance
Operations > Create Custom Request, and then Next.

¢) Inthe Certificate Enrollment Policy wizard, choose Proceed without enrollment policy
under Custom Request, and then Next.

d) On the Custom request screen, choose (No template) CNG key from the menu and
PKCS#10 for the Request format, and then Next.

e) On the Certificate Information screen, choose Details and then Properties.

f) Onthe General tab, type a friendly name and description.

g) On the Subject tab, under Subject name, choose Common name, and type a value in the
text box.

h) On the Extensions tab, choose Key usage from the menu, add Digital signature and Key
encipherment.

i) Onthe Extensions tab, choose Extended Key usage from the menu, add Server Authen-
tication and Client Authentication.

j) On the Private Key tab, under Cryptographic Service Provider, choose RSA, Microsoft
Software Key Storage Provider (the default). From the Key options menu, ensure that
the key size is 2048, select the Key Exportable check box, and then Apply.

k) Save the file to a .req file, submit the .req file to a Certificate Authority (CA), and save the
.cer file.

2. In the MMC, under Certificates, right-click Personal and choose All Tasks > Import. In the Im-
port wizard, select the .cer file.

3. Create a directory c:\ls_cert to hold the exported .pfx file.

4. In the Certificates console, choose Personal > Certificates, and choose the certificate you im-
ported. Select All Tasks > Export > Next, and select the Yes, Export the Private Key radio
button and Next.

5. Under Personal Information Exchange - PKCS #12(.PFX), select the check box to include all
certificates, choose Next, create a password, and then choose Next.

6. Choose Browse, navigate to C:\ls_cert and type server.PFX, and then follow the wizard to fin-
ish.

How to extract the certificate and private key

This step requires OpenSSL or another tool that allows you to extract the certificate and private key
from a .pfx file. The version of OpenSSL shipped with the License Server does not support extracting
certificates and private keys. For information about downloading OpenSSL, go to www.openssl.org.
Citrix recommends installing OpenSSL on a separate workstation to perform these steps:

1. Navigate to the <openss’l directory>\bin folder.
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2. Run openssl pkcsl2 -in C:\1ls_cert\server.pfx -out server.crt -

nokeys
Note:

The License Server uses only the .crt certificate format.

3. Type the password created during the export process (password).

4. Run openssl pkcsl2 -in C:\ls_cert\server.pfx -out server.key -

nocerts —-nodes

5. Type the password created during the export process (password).

How to install the . crt and . key files on the License Server

Windows - Web Services for Licensing:

1. Stop the Citrix Web Services for Licensing service.

2. Copy the server.crt and server.key created earlier in this procedure to c: \program files
(x86)\citrix\licensing\WebServicesForLicensing\Apache\conf\.

3. Start the Citrix Web Services for Licensing service.

Windows - License Administration Console:

Note:

« License Administration Console was removed from Windows License Server v11.16.6.0
build 31000 and onwards. For more information, see What’s new.
+ License Server VPX still uses License Administration Console.

1. Stop the Citrix licensing service.

2. Copy the server.crt and server.key created earlier in this procedureto c: \Program Files
(x86)\Citrix\Licensing\LS\conf.

3. Start the Citrix licensing service.

Step 5 Configure a proxy server

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure
a proxy server, requests to download licenses and upload Call Home data are sent through a proxy

server.

Important:

Citrix Licensing components requiring outward bound web communications can inherit network
proxy settings using Windows automatic proxy detection. We do not support authenticated prox-
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ies. For more information about Windows automatic proxy detection, see WinHTTP AutoProxy

Functions.

How to configure a proxy server manually

1. Edit the SimpleLicenseServiceConfig.xml file, which is in the <Citrix Licensing>\
WebServicesForLicensingdirectory.
2. Add a line of xml to the file in the format <Proxy>proxy server name:port number

</Proxy>

Important:

The .xml tags are case-sensitive.

<Configurations>
<EncoreConfiguration>
<SamplingPeriod>15</SamplingPeriod>
<RetentionTime>180</RetentionTime>
<Enabled>true</Enabled>
</EncoreConfiguration>
<Proxy>10.211.55.5:808</Proxy>
</Configurations>
<!--NeedCopy-->

Next steps

« Citrix Licensing Manager
+ Product specific licensing guides

Upgrade the License Server

December 18, 2023

Before you upgrade

The following information helps you to prepare well before you begin your upgrade.

« Each time you upgrade your Citrix product, upgrade the Citrix License Server also. Each time
a new License Server is released, it might contain better security, fixes to known issues, and so

on.
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+ Sometimes, new versions of the Citrix product are incompatible with older versions of the Li-
cense Server. New versions of the License Server are compatible with older versions of the
product and old licenses.

« Version upgrade is moving from any previous version of a product to the newest version of the
product. For example, moving from XenDesktop 7.18 to Citrix Virtual Desktops 7 1909.

+ Edition upgrade means the purchase of a higher edition level of a product. For example, you
now have Advanced Edition and you purchase upgrade to Premium Edition.

Prerequisites and precautions

« Forinformation about system requirements, see System requirements.

+ Ensure you download the latest version of License Server, go to Citrix Downloads.

« Installing the License Server from a UNC path (\\server\share). Install the License Server from
your local copy.

+ Upgrade your licensing components before upgrading your product, if necessary.

+ Uninstall any versions of Citrix Licensing older than version 11.12.1 before installing this version.

+ To avoid the failure of any subsequent License Server upgrades: Ensure that when you installed
your License Server, you successfully configured it with the post installation License Server Con-
figuration tool or uninstalled your previous License Server.

How to upgrade the License Server

Citrix recommends that you install the newest License Server. The new License Server is backward
compatible and supports older products and license files. However, new products require the newest
License Server to check out licenses correctly. Perform the following steps to upgrade your License
Server:

1. Go to the Citrix Downloads page and download the installer to install or upgrade to the latest
version.

2. Startthe License Server installer (CitrixLicensing.exe) as an administrator, and follow the graph-
ical interface.

To upgrade the License Server from your product media:

If you use the product media for your installation, you might have to enable some functionality by us-
ing the Citrix Licensing Manager after your installation. For example, use the Citrix Licensing Manager
to enable Customer Success Services renewals.

1. From your License Server, open the media for your product.
2. If you do not see Setup, use Windows Explorer to open Autorun.exe or AutoSelect.exe.
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3. Navigate through the Setup screens to Citrix Licensing and follow the instructions.

To upgrade the License Server from the command line:

Ensure that you run the command line with administrator privileges. To start the command prompt
with elevated privileges, choose Start, right-click Command Prompt, and choose Run as adminis-
trator.

You cannot change ports during command line upgrades.
The following sample command line installs licensing in silent mode.

CitrixLicensing.exe /quiet /linstall.log INSTALLDIR=installdirectory CEIPOPTIN=ANON

« /quiet specifies a silent (quiet) installation.

+ /lspecifies the log file location

« INSTALLDIR is the location where the License Server executable is stored. Optional parameter.
The default is c:\program files\citrix licensing or c:\program files (x86)\citrix\licensing.

+ CEIPOPTIN specifies whether, or how, to opt in to Citrix Customer Experience Improvement Pro-
gram (CEIP) or Call Home. Optional parameter. The default is ANON.

- DIAG - Call Home
- ANON - CEIP
- NONE

You can modify the CEIP and Call Home choice using the Citrix Licensing Manager.
Important

The Citrix Service Provider program requires Customer Experience Improvement Program (CEIP)
and Call Home. If you are a Citrix Service Provider, you cannot disable CEIP or Call Home.

Events during a License Server upgrade

As part of the License Server upgrade, we stop services, upgrade the License Server, and then restart
services. During the upgrade, products enter the grace period and self-license. When the License
Server is online again, all product servers return from the grace period and reconcile license counts.
This grace period works in the same manner as the regular grace period functionality.

How to upgrade licenses for your edition

If you are eligible for a version upgrade as a benefit of your maintenance, you can download your
CSS Renewal license and add it to the License Server. Also change the product edition setting in the
product user interface. It’s best to change the product edition setting when there are few connections
to the affected servers or redirect connections to another computer. When you change the product
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edition setting, restart the product server for changes to take effect. See the product documentation
for changing the edition setting. If you add the upgrade license to the License Server before you set
the edition to the new edition, the Citrix product stops accepting new connections.

Perform the following steps to upgrade edition licenses:

I e

From a web browser, go to http://www.citrix.com.

Choose Log In and type your user ID and password.

Select Manage Licenses.

At the bottom of the landing page, select Upgrade my licenses.

Follow the site options and instructions for upgrading your product edition licenses.

Either download or order new media. An email message provides you with instructions toreturn
to citrix.com to allocate or receive more feature licenses.

Log on to www.citrix.com to allocate your licenses, generate a license file, download the license
file to your License Server, and reread the file.

Uninstall the License Server

March 18,2024

If you want to uninstall License Server from your server completely or have issues with the current

version and prefer a clean installation, you can choose to uninstall it. You have the flexibility to use
either the GUI or the Windows command line for the uninstallation process.

Note

The My f1les folder is kept even after successful uninstallation in the file path C: \Program
Files (x86)\Citrix\Licensing\MyFiles. To make surethatthereis no interruption

on the Citrix products.

Uninstall the License Server using the GUI

To uninstall License Server, do the following steps:

1. In the Search on the taskbar, enter Control Panel and select it from the results.

2. Select Programs > Programs and Features.
3. Drag (or right-click) on Citrix Licensing and select Uninstall or Uninstall/Change. The Citrix

Licensing wizard appears.

. Click Remove and then click Yes when prompted for Are you sure you want to remove?.

Click Finish. The License Server has been successfully removed.
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Uninstall the License Server using the Windows command line

To uninstall License Server, run the following command in the Windows command line:
CitrixLicensing.exe /quiet /uninstall /1 uninstall.log

To re-install, download License Server from Downloads and Install.

Prerequisites to obtain your license files

October 7, 2023
After you install the licensing components, you are ready to obtain your license files.

You can obtain your license files in several ways:

« Studio in Citrix Virtual Apps and Desktops. For more information, see Citrix Virtual Apps and
Desktops Licensing.

« Citrix Licensing Manager.

+ MyAccount on citrix.com. For more information, see Manage Licenses on citrix.com.

Ensure you have the following information ready, before going to the Citrix website to get your product
licenses:

+ Your user ID and password for My Account.

+ The license access code. You can get this code in My Account on citrix.com or in an email you

receive from Citrix.

Note: If you cannot locate the license access code or licenses you purchased, contact the Citrix
Customer Service.

« The hostname of the License Server on which you installed the licensing components. The
License Server hostname is case-sensitive, so ensure that you copy the name exactly as it ap-
pears on the system.

Select the down arrow in the top bar of the Citrix Licensing Manager screen to find the License
Server hostname, Ethernet address, and IPv4 address. You can also run the hostname com-
mand at a command prompt on the License Server.

« How many licenses you want to include in the license file. You do not have to download all
the licenses you are entitled to at once. For example, if your company purchases 100 licenses,
you can allocate and download only 50 now. Later, you can allocate the rest in another license
file. You can have more than one license file based on the number of licenses allocated.
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Citrix Licensing Manager

October 7, 2023

The Citrix Licensing Manager is a web-based management console for Citrix Licensing. It enables the
License Server features using a simple web interface. For more information on the functions you can
perform using the Citrix Licensing Manager, see the Citrix licensing technical overview.

The Citrix Licensing Manager is installed on the license server. You can only use it to manage the
license server on which itis installed. The Citrix Web Services provide the functionality for the Licens-
ing windows service.

Access the Citrix Licensing Manager using the link https: //+xLicenseServerName:WSLPortx*.
The default WSL Port is 8083.

Citrix Licensing Manager

Dashboard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL N USE/INSTALLED AVAILABLE
Citrix Start-up License Server 0/10000 10000{100%) >
Citrix License Server Diagnostics License Server 0/10000 10000{100%) >

The Citrix Licensing Manager screen displays the following details:

» The License Server version in the top bar of the screen. You can also view the host name, Ether-
net address, and IPv4 address, from the drop-down list in the titlebar.
by selecting the down arrow at the top right of the Citrix Licensing Manager screen.

« Important notifications of license availability, expiration, and other conditions. You can view
these notifications by selecting the bell icon at the top of the Citrix Licensing Manager screen.

The Citrix Licensing Manager also allows you to perform the following actions:

+ Configure Customer Success Services renewal license actions. Specify whether to download
and install licenses automatically, check for the available renewals and notify, or manually in-
stall the licenses. For more information on configuring this feature, see Check for and install
Customer Success Services renewal licenses with the Citrix Licensing Manager.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 67


https://docs.citrix.com/en-us/licensing/current-release/license-server/licensing-technical-overview.html
https://docs.citrix.com/en-us/licensing/current-release/customer-success-services.html#check-for-and-install-customer-success-services-renewal-licenses-with-the-citrix-licensing-manager
https://docs.citrix.com/en-us/licensing/current-release/customer-success-services.html#check-for-and-install-customer-success-services-renewal-licenses-with-the-citrix-licensing-manager

Licensing 11.16.6

« Store and export historical usage reports from the License Server. You can specify a date range
forthe historical usage data and exportitto a CSVfile. The CSV file provides daily usage informa-
tion including the number of licenses in overdraft. For information about exporting historical
usage data, see Historical Use.

Prerequisites

See the System requirements for Citrix Licensing article to understand the prerequisites and require-

ments.

Where to go next

« Dashboard: View details about the installed, in-use, available licenses, expiration date of li-
censes, and Customer Success Services dates.
For more information, see Dashboard.

« Historical use: Review and export data related to products, license models, and Customer Suc-
cess Services (Subscription Advantage) dates.
For more information, see Historical Use.

+ Install licenses: Install license files on the License Server using a license access code or down-
loaded file. View details of licenses after they are installed.
For more information, see Install licenses.

« Update licenses: Check for, download, install, and update available Customer Success Services
renewal licenses.
For more information, see Update licenses.

« Settings: Modify settings related to user and group accounts, server configuration, and usage
and statistics data. For more information, see Settings.

Dashboard and Historical Use

October 7, 2023

Dashboard

The Dashboard in Citrix Licensing Manager provides information about product edition, model, in-
stalled or in-use status and availability of your licenses.
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Citrix Licensing Manager = = Hello,

Dashboard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL IN USE/INSTALLED AVAILABLE
Citrix Start-up License Server 0/10000 10000(100%) >
Citrix License Server Diagnostics License Server 0/10000 10000(100%) >

To view detailed information about the licenses, click > for a particular license. The Citrix Licensing
Manager displays a table containing the following details of the license:

Customer Success Services date

Total installed licenses
Overdraft
Licenses in use

Available licenses

Expiration date
» Type
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Citrix Licensing Manager

Dashboard Historical Use Install Licenses Update Licenses
License Usage
PRODUCT-EDITION MODEL IM USE/INSTALLED AVAILABLE
Citrix Start-up License Sernver 0/10000 10000{100%) A
Licenses
£S5 Date Total Installed Owverdraft In use Available Expiration Diate Type
2038.0101 10000 0 0 10000 PERMANENT System
Citrix License Server Diagnostics License Server 0/10000 10000{100%) >
Note:

The dashboard data updates every five minutes.

Historical Use

The Historical Use feature in the Citrix Licensing Manager allows you to store and export historical
usage reports from the Licensing Server. The default retention period is one year. You can view and
specify the data retention period by selecting Change. Use the filters to export a License Server Prod-
uct usage report as a CSV file.
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Citrix Licensing Manager

Historical Use

Product & Edition Model
Citrix 'f1'..1|t-|.[:Llfl-_"'lj.qf':'i: TRIX o B -
Customer Success Services Date Start Date End Date
2038.0101 - 01/14/2019 [E 01/16/2019 [i]

Histoncal data is retained 180 Days Change

Export historical usage data

You can view and export the historical usage by performing the following steps:

1. Logontothe Citrix Licensing Manager hosted on the License Server. Type the following URL into
a browser on a system having access to the License Server, and use your actual License Server
host name.
http://License-Server-Hostname:8083/

2. Select Product & Edition, Model, and Customer Success Service Date. Enter a date range for
which you want to gather the history.

Note:

Selecting Customer Success Services date limits exported data to a specific pool of licenses
and does not accurately reflect the total number of licenses in use.

3. Select Export.

4. Select Save > Save As on the browser download dialog to save the exported CSV file. The CSV
file provides daily usage information, including the number of licenses in overdraft.
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Install licenses

October 7, 2023

The Citrix Licensing Manager gives you the following options to obtain your licenses:

+ Use license access code
+ Use downloaded license file

Inthe Start menu, select AllPrograms > Citrix > Citrix Licensing Manager, or from a remote machine
usethe https://licenseservername: 8083 URL with your License Server name.

Citrix Licensing Manager

Install Licenses

Licende Server Information

bClasl mal 1061 45

® Use license access code se downloaded license file

License Access Code

XDT-PLT-CCS

Use license access code

1. Choose Use license access code, and enter the license access code provided by Citrix.
2. Click Display Licenses to see your license entitlements.
Select the licenses and the quantity to install.

3. Select a product from the displayed list, type the number of licenses to install, and click In-
stall. To select multiple products, click Install every time you select a product. The products
are processed in order of selection.
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4. To display the newly downloaded licenses, click Dashboard.

@) Use license access code ("1 Use downloaded license fila

License Access Code

XDOT-PLT-CLS

Display Licenses

Product Name Quantity/Available Already Used
Citrix XenDesktop Platinum | Concumrent 5 /5 0
Product-Type (55 Date Available

¥ CEHY| CCS-Rerail

I CESEF | CCU-Retail

I MMPS | CCU-Retail

License Entitlements

Action/Progress

W Installed

Fxpiry Date

Use downloaded license file

(") use license access code (@) Use downloaded license file

License File

Choose File

Installed License Details

Product-Type CSS Date Awailable
w Citrix Xenfpp Enterprise | Concurrent User-Retail

20181301 10

Expiry Date

01-dec-2018

1. Choose Use downloaded license file.

2. Choose afile.

3. Choose the check box to replace an older file with the same name.
4. Click Import.

The Citrix Licensing Manager displays information about the licenses.
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5. After your license file is successfully uploaded to the License Server, a message displays. To
display the newly downloaded licenses, click Dashboard.

Note:

Avoid issues while uploading a license file by removing special characters in the file name.
Ensure that the file has a .lic extension (all lower case).

Allocating and downloading licenses

Consider the following points while using the Citrix Licensing Manager to allocate and download li-
censes:

« As a prerequisite, ensure that you have internet access or a configuration with a proxy server.

« Once you click Allocate > Download, you cannot cancel it. If this action fails, use My Account
at citrix.com.

+ The Citrix Licensing Manager doesn’t support redownloading or reallocating of license files. You
can return licenses on citrix.com and use the Citrix Licensing Manager to allocate them again.
For redownloading, use My Account.

« If you rename the License Server, you must reallocate any license files allocated under the old
License Server name.

Update licenses

June 10, 2021

Install your Customer Success Services renewal licenses from the Update Licenses tab in the Citrix Li-
censing Manager. You can also see a record of the recently installed renewal licenses in the Customer
Success Services renewal licenses renewed in the last 30 days section.

To update the licenses

1. In the Customer Success Services renewal licenses available section, click Check for Avail-
able Renewals.

2. Click Download and Install to install the licenses. For more information see Use downloaded
license file section in Install licenses.
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Citrix Licensing Manager

Diashboard Histarical Use Irsstall Licenses Update Lcenses

Update Licenses

License Server Infomation

Hestrame  co-deld IP doress 100614485

Customer Success Services renewal licenses avallable

i Tor Akl [
Product Name Cuantity 55 Date Action
Cinrix XenDeskuop Flatinum | User/Tevice 1 018.1201 Dawmioad and install

Customer Success Senvices renewal licenses installed inthe last 30 days

o renewal licenses were installed

Settings

October 7, 2023
Modify and configure the following settings in Citrix Licensing Manager:

+ Account: Configure user and group accounts.

+ Server configuration: Configure ports and Customer Success Services renewal license actions.

« Usage and statistics: Register your License Server with Citrix Cloud and configure the historical
data retention by selecting a retention period.

To configure these settings, click the settings icon on the top right corner of the title bar.
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Citrix Licensing Manager

Dashboard Historical Use Install Licenses Update Licenses

License Usage

PRODUCT-EDITION MODEL M USE/INSTALLED AVAILABLE

Citrix Start-up License Server 0/10000 10000{100%) >

Citrix License Server Diagnostics License Server 0/10000 10000{100%) >
Account

On the Account tab, configure users and group access for both local Windows users and groups and
Active Directory users and groups.

Note:

Active Directory users and groups are part of an Active Directory or network authentication sys-
tem. To support them, ensure that the Windows License Server is a member of a Microsoft Active
Directory domain.

Users are configured with local roles. All users created as administrators can:

+ Select a console display language.
+ View system information.
« Add and remove users.

Configure the License Server port.

Configure the vendor daemon port.

Configure the Web Services for Licensing port.

Configure and add licenses.
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Citrix Licensing Ma
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Settings
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To add and remove users and groups

To add a user or a group, click Add, choose User or Group, enter Domain\Username, and then click
Finish.

To remove a user or a group, click User or Group from the list and then click Remove.

To edit the role of an existing user or group, click the edit button, choose the role, and click Update.

Server configuration

Use the Server Configuration setting to make the following changes:

Configure the License Server, Citrix vendor daemon, and Web Services for Licensing ports.

Configure Customer Success Services renewal license actions.

Enable and disable the supplemental grace period.

Select the console display language.
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Settings

Account  Server Configuration Usage and Statistics

Configured Ports

License Server Port @ 27000
Vendor Daemon Port i 7279
Web Services for Licensing Port @ a083

Customer Success Services Renewals ()

{ ) Manually check for Customer Success Services renewal licenses.

(@) Automatically check for Customer Success Services renewal licenses and notify when available.

{ ) Automatically check for and install Customer Success Services renewal licenses when available.

Supplemental Grace Period

Start the 15-day supplemental grace period when the regular license consumption limit is
reached

Language English &
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Configure port numbers

You can edit the following default ports:

+ License Server. This port number is used by the Citrix Licensing Manager. License Server Man-
ager handles the initial communication among the products, starts the Citrix vendor daemon,
and relays check out and check in requests to the vendor daemon. By default, this port number
is 27000.

« Citrix vendor daemon. This port number is used by the Citrix vendor daemon. The vendor
daemonisresponsible for the core operations of the License Server, including license allocation.
By default, this port number is 7279. However, if you have a firewall or if the number is already
in use, you must change the port number.

+ Web Services for Licensing. Port used by the Web Services for Licensing. The Web Services
for Licensing hosts the Citrix Licensing Manager, so users connecting to the Citrix Licensing
Manager use this port. Director and Studio use this port to communicate with the License Server
using Web Services for Licensing. By default, this port number is 8083.

Customer Success Services Renewals

This feature checks for already available renewed licenses, and notifies they are available for renewals,
or automatically installs them. When enabled, the Citrix Licensing Manager contacts Citrix.com web
services weekly to check for available Customer Success Services renewal licenses.

You have the following options to renew Customer Success Services licenses:

« Automatically check for Customer Success Services renewal licenses and notify when
available

« Automatically check for and install Customer Success Services renewal licenses when
available

« Manually check for Customer Success Services renewal licenses

The check foravailable renewals is performed weekly. To manually update your licenses, click Update
License > Check for Available Renewals. Check the Update License tab at any time to see a list of
licenses installed in the last 30 days.

Based on your configuration, the Citrix Licensing Manager does one of the following:

+ Checks for Customer Success Services renewal licenses, notifies you, and installs the licenses
when found.

» Checks for Customer Success Services renewal licenses, and notifies you they are available to
be installed.

+ Allows you to check manually.
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If the automatic checks for Customer Success Services renewal licenses fail, check the firewall setting
or configure a proxy. For this feature to work, the License Server must be able to access https://citrix

services.citrix.com.

Supplemental grace period

You can use the Supplemental grace period feature to start the 15-day supplemental grace period,
when you reach the regular license consumption limit. During the supplemental grace period, the
product allows unlimited connections for 15 days, enabling you to fix the issue. Ensure you check your
product documentation to determine if your product supports the supplemental grace period.

Language

You can change the default language of the Citrix Licensing Manager display, which applies to all the
console users. The following languages are available:

+ Chinese (Simplified)
+ English

 French

« German

» Japanese

« Spanish

Usage and Statistics

Use the Usage and Statistics setting to do the following:

+ Configure how you share usage statistics with Citrix.

« Find out if your License Server is registered, or register your License Server with Citrix Cloud.
« Know the status of your uploads, and fix failed uploads.

«+ Force data upload to Citrix.

+ Set the period to retain the historical usage information.
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Citrix Licensing Manager

Dashboard Higtarical Use Ineatall Licendes Update Licenses

Settings

Acoount Server Corfiguraticn Usage and Statistics
—————

Share usage statistics with Cirrb
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Register and remove registration of your Citrix License Server

Use the Register option in the Usage and Statistics section to register your Citrix License Server with
Citrix Cloud. Once registered, the screen indicates that you are registered. Use the Remove Registra-
tion option if you want to remove the License Server registration. For more information, see Register
Citrix License Server with Citrix Cloud.

Share usage statistics

The Citrix Licensing Customer Experience Improvement Program (CEIP) and Call Home usage and ana-
lytics programs are voluntary data collection programs designed to improve your product experience.
CEIP is enabled by default during License Server installation. Call Home is voluntary. You can partici-
pate in the programs anonymously, choose to be identified, or decline to participate. You can change
your participation in the program at any time by using the Citrix Licensing Manager.

For more information about the statistics that are collected, see Citrix licensing Customer Experience
Improvement Program (CEIP), Call Home, and compliance usage and analytics programs.
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Important:

The Citrix Service Provider program requires CEIP and Call Home. If you have Citrix Service
Provider licenses installed, you can only change the settings and not disable CEIP or Call Home.

Configure usage telemetry

By using this feature, you have the option of allowing Citrix to collect data from the License Server.
You can choose to send data in an unidentifiable format, or choose not to send data.
You have the following options:

+ Selectthe Send identifiable user name and device ID data option to send your user name and
device ID.

« Select Replace identifiable user name and device ID data with non-identifiable values be-
fore transmission options to send your user name and device ID in a non-identifiable format,
once you have selected the Send identifiable user name and device ID data.

+ Do not select the Send identifiable user name and device ID data option if you don’t want
you send your user name and device ID.
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Account Server Configuration Usage and Statistics

Share usage statistics with Citrix

@ Allow Citrix to collect system information, license usage, and user/device data from your License Server.
Providing this data and registering your License Server with Citrix Cloud helps you and Citrix understand
how your licenses are used over time.

Register this License Server to enable License Usage Insights in Citrix Cloud.

*i:f' Help improve Citrix products by sending detailed License Server system and usage information (which
does not identify users) to the Citrix Customer Experience Improvement Program (CEIP).

- j ) Send only basic License Server system and usage information (which does not identify users) required for
license compliance purposes.

Configure usage telemetry
Send identifiable username and device ID data.

Replace identifiable username and device ID data with non-identifiable values before transmission.

Learn more about the License Server information collected by the License Management Service and additional
collection options and information.

Upload Information

Upload information

Prowvides status for the last Citi Custamer Experience Impraveiment Progiam (CEIP), Call Home, ar Cilvix Semice Provider
Program upload.

Last successful upload 5/21/2020, 10,1938 AW

Upload now

© 1999-2024 Cloud Software Group, Inc. All rights reserved.

83




Licensing 11.16.6

This Upload information feature provides the status for the last CEIP, Call Home, or Citrix Service
Provider upload. You can force a data upload to Citrix without waiting for the daily upload. Click
Upload now to force a data upload to Citrix, when CEIP is enabled. For successful uploads, allow five
minutes between uploads.

If the upload fails, the Citrix Licensing Manager displays the troubleshooting information.
Historical Use

Use the Historical Use feature to choose the retention period to retain your License Server usage
information. The default historical use retention period is one year.

Historical Use

Retention Period i 1 Year &

Register and remove registration of your Citrix License Server

December 20, 2023

Register your Citrix License Server

Register your Citrix License Server with Citrix Cloud, by using a short-code activation process, using
the Register option in the Usage and Statistics section of the Settings.

Once registered, the screen indicates that you are registered, and you can use the Remove Registra-
tion option to remove the License Server registration.

By registering the License Server with Citrix Cloud, you allow the License Server to collect and store
the Call Home license usage information, and regularly transmits that data to Citrix Cloud.

For steps to register an on-premise License Server, see Register on-premises products with Citrix
Cloud.

View the status of your Citrix License Servers to understand which ones are successfully reporting
usage and when they last reported usage to Citrix Cloud. For more information, see Monitor licenses
and usage for on-premises deployments.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 84


https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-registration.html
https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-registration.html
https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-license-usage.html
https://docs.citrix.com/en-us/citrix-cloud/citrix-cloud-management/citrix-cloud-on-premises-license-usage.html

Licensing 11.16.6

After your License Server is registered successfully in Citrix Cloud, you can view the details in the Citrix
Cloud UL.

Important:

Before registering your License Server with Citrix Cloud, use the firewall rules to open the follow-
ing URLs:

https://trust.citrixnetworkapi.net:443
https://trust.citrixworkspacesapi.net:443
https://cis.citrix.com port 443
https://core.citrixworkspacesapi.net:443
https://core-eastus-release-a.citrixworkspacesapi.net
https://core.citrixworkspacesapi.net
ocsp.digicert.com port 80
crl3.digicert.com port 80
crl4.digicert.com port 80
ocsp.entrust.net port 80

crl.entrust.net port 80

crl.entrust.net port 80

Ensure that the License Server can access the Certificate Revocation List server for DigiCert and
Entrust. The License Server checks the server to see if the required certificates are valid or re-
voked.

Steps to register your License Server

To register your License Server by performing the following steps:

1. Navigate to Settings > Usage and Statistics.

2. Click Register to generate an 8-character alphanumeric code.
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Use this code to register this License Server with Citrix
Cloud

bal -

5P 5V - 6UWX [on]

The: code expires in 19 minutes 38 seconds

3. Select View details to view your License Server version, MAC ID, host name, and IP address.
4. Click Register. You’re navigated to the Citrix Cloud sign-in page.

5. Enter your Citrix Cloud account credentials and navigate to Product Registration > Register.
Enter the 8-character alphanumeric code, and click Continue.

6. Review the registration details and click Register.

Note:

If you’re not redirected to the Product Registration experience, do the following:

1. Go to citrix.cloud.com and sign in to Citrix Cloud.
2. Selectyourcompany, select Identity and Access Management >API Access tab > Product
Registrations from the select menu.

Remove registration of your License Server

If you want to register your license server with a different or new Citrix Cloud account, remove the
registration and re-register the license server.
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To remove your license server registration navigate to Settings > Usage and Statistics, and click Re-
move Registration. Review and confirm the confirmation message.

JAN

Remove reglstration with Cltrix Cloud

The registration of your License Server is removed from Citrix Cloud. You can now follow the steps to
register your license server and register with a new Citrix Cloud account.

Use Manage Licenses in My Account on citrix.com

December 18, 2023
Note:

Citrixis working to improve the licensing experience in My Account on citrix.com. You can choose
Manage Licenses to easily find, allocate, download, modify, return, hide, and unhide licenses.

There are several administration procedures that you can do without using the Citrix Licensing Man-
ager. We recommend that you use the appropriate console whenever possible.

You can also use Manage Licenses at citrix.com. This article describes how to manage licenses on

citrix.com.
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Introduction to licensing concepts
New licenses

You can display only new licenses by choosing New Licenses in the Filter by menu.

+ New licenses are the licenses you purchased from Citrix within the last 30 days.
« The new licenses section displays the top five recent purchases.
+ New licenses are indicated with a green bar and the word (New) in green.

I () Citrix virtual Apps and Desktops Premium Edition {New}

+ YoucanAllocate licenses from the landing page only for new licenses. Select the required license
and start the allocation process by clicking Allocate licenses.

Expiring term licenses

You can display only expiring licenses by choosing Expiring Licenses in the Filter by menu.

+ Expiring licenses are term licenses that are expiring within 90 days.
« Licenses expiring within 0 through 30 days are displayed with a red bar. Licenses expiring within
31 through 90 days are displayed with an orange bar.

Expiring term licenses

Product name Licerse a00ess code - Allocated Expires

+ The Expires column shows the number of days until the license expiry date.
« The Allocated column shows the allocated quantity and total purchased quantity.
+ The expiring licenses section shows the 5 most recent purchases.

Glossary

Allocate licenses: When you allocate licenses, you apportion purchased licenses by product and Li-
cense Server so you can split them among multiple environments or use cases. For example, your
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organization might own 1,000 licenses for the same product. You might want to use 800 in 1 location
and 200 in another location. You can allocate 800 licenses to a License Server in the first location
today, and allocate the remaining 200 later to a different License Server.

Asset components: Asset components are the license details.

CSV files: The Excel CSV file provides daily usage information, including the number of licenses in
overdraft.

Modify licenses: Choosing to modify licenses, returns the license file and allocates it to another Li-
cense Server.

Return allocations: When you Return licenses, you put the licenses back in the licensing pool. You
can then allocate these licenses in any quantity at any time. After you return a license, remove the old
license file from the License Server.

Term licenses: Term licenses are purchased for a specified amount of time and have an expiration
date.

To access Manage Licenses on citrix.com

1. From a web browser, go to http://www.citrix.com.

2. Select Sign In > My Account and type your user ID and password.

3. Select Manage Licenses.
I ———

.
CITRIX Presducts Downloads Support & Services Partners E - =

Manage Licenses
@ My Int CrErveEw

[;u'

DEARo % F

License aooess ode  * dlocated

(]
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Search for licenses

+ In the Find a license by... menu, choose the search criterion, type the search text, and select
Search.

You can select Show advanced search options to further narrow down your search.

Allocate licenses

1. Select the licenses you want to allocate. The landing page displays only new licenses within 30
days and expiring term licenses. You can use the Find a license by... search to find all licenses
using one of the search criteria and then the Filter by menu to narrow the display down to
specific types of licenses or you can select Quick find: All active to see all licenses.

2. From the Select an action menu, choose Allocate licenses.
3. Enter host name and how many licenses to allocate, and click Create license file.

4. Select Yes, create license file. If you want to make a change before creating the license file,
select No, modify the allocation, and make your change. Then select Yes, create license file.

5. Select Download license file, and save the file to a temporary location. Remember the file
name and location where you downloaded the file. You need this location.

6. Install the license. See Install licenses.

Download licenses

1. Selectthelicensesyouwanttodownload. Thelanding page displays only new licenses within 30
days and expiring term licenses. You can use the Find a license by... search to find all licenses
using one of the search criteria and then the Filter by menu to narrow the display down to
specific types of licenses or you can select Quick find: All active to see all licenses.

2. From the Select an action menu, choose Download all licenses, and save the file to a tempo-
rary location. Remember the file name and location where you downloaded the file. You need
this location.

3. At a command prompt, navigate to the folder and type the following command:

Imreread -c @localhost -all

For more information about the Ilmreread command, see Reread license and options files (Imr-
eread).
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Install licenses

1. Choose Download license files, and save the file to a directory.

2. Atthe License Server, copy the license file from the directory where it was saved tothemy files
directory.

Ensure that the license file retains the lower case .lic file name extension. Some copy processes
don’trecognize a file type for that extension and add a “.txt”file name extension during the copy.
You can’t import license files that have the wrong file name extension.

« C:\Program Files\Citrix\Licensing\MyFiles on a32-bitcomputer
e« C:\Program Files (x86)\Citrix\Licensing\MyFilesona®64-bitcomputer

3. At a command prompt, navigate to:

« C:\Program Files\Citrix\Licensing\LS ona32-bitcomputer
o« C:\Program Files (x86)\Citrix\Licensing\LS on a64-bitcomputer

And type the following command: lmreread -c @localhost -all

For more information about the Ilmreread command, see Reread license and options files (Imr-
eread).

Asset components

Asset components are the To display asset components click View my products at the top of the
screen. Choose a license and click the down arrow to expand and view the details. You can toggle
between the order number and the license access code view.
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Find a license by... Clear search

Licensessenal number

Purchase date FCH Active only

Hide advanced search options

Export list (C3V) £

Product name Cirder Number T Quantity

= Virtual Desktops Service 5880
Purchased: 12/22/2018 Bxpiring: 12/22/2021

@ | Endpoint Management Service 2500
Purchased 13/23/2018 Expiring: 12/32/3021

Mame License access code ¥ Quantity
Endpoint Management Sandce 2500
Workspace Emaronment Management 2500
Citrix VPX 3000 MBPS License FJ
Citrix Connector VX 200Mbps i
= Virtual Deskiops Service 4200

Purchaced 127233018 Expiring: 12/32/30F1

@ Virtual Deskiops Service 300
Purcharsedt 13/22/2018 Expiring: 12/23/3031

Return allocations

Returningallocations puts thelicenses backin the licensing pool. These licenses can then be allocated
in any quantity at any time. For example, you’re decommissioning a License Server, but you’re not
ready to deploy existing licenses elsewhere.

1. Select the check box of the licenses you want to return.
2. From the Select an action menu, choose Return allocations.
3. Select Yes, process return. If you choose this option, you cannot undo it.
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Modify licenses - returns and allocates licenses to another License Server

Modifying a license returns a single license file and allows for allocation to another server. For exam-
ple, you have 5000 licenses installed on license serverl. You want to move 1000 licenses to license
server2. Modify allocations and then allocate 4000 licenses to license serverl and 1000 licenses to
license server2.

To select a product, click the link, and view the product license details page.
Select the check box of the allocated license to modify.

From the Select an action menu, choose Modify allocations.

Type a new server host address.

Select Modify license file.

oA~ W

Select Yes, create license file. If you want to make a change before creating the license file,

select No, modify the allocation, and make your change. Then select Yes, create license file.

7. Select Download license file, and save the file to a temporary location. Remember the file
name and location where you downloaded the file. You need this location.

8. Install the license. See Install licenses.

Upgrade license edition

If you are eligible for a version upgrade as a benefit of your maintenance, you can obtain a new license
and add it to the License Server.

1. Atthe bottom of the landing page, select Upgrade my licenses.

2. Follow the site options and instructions for upgrading your product edition licenses.

3. Eitherdownload or order new media. An email message provides you with instructions to return
to citrix.com to allocate or receive more feature licenses.

4. Logon to www.citrix.com to allocate your licenses, generate a license file, download the license
file to your License Server, and reread the file.

Hide and unhide licenses

Hiding licenses doesn’t remove them from an account. When you hide licenses, it removes them from
view. You might want to hide legacy product licenses. Hiding those licenses increases the visibility of
product licenses that you want to view.

1. Select the licenses you want to hide.

2. From the Select an action menu, choose Hide licenses.

3. To unhide licenses, choose Quick find: All hidden and select licenses.
4. From the Select an action menu, choose Unhide licenses.
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Manage multiple licenses (bulk actions)

You can apply actions to multiple licenses at the same time. Select the check boxes of different li-
censes and then select and action.

To successfully apply actions to multiple licenses, be aware of these considerations:

« You can apply certain actions only to licenses with the same attributes. For example, you can
only allocate licenses that have the same binding type. An error message appears when you
select licenses that are not compatible for the bulk action.

The first license you select is what subsequent selections are compared to for compatibility.

« If you select licenses that can’t have an action applied to all of them, some actions might be
disabled or not displayed, and a message might appear. For example, if you select two licenses,
one that has been allocated and one that has not, a message appears. The message states that
the action can apply only to allocated licenses.

Bulk actions X

One or more licenses are not allocated.

You can only apply this action to items that have been allocated.

If you continue, any licenses that have not been allocated are ignored.

Close and change selection

Filter licenses

Use the Filter by menu to narrow your list to expired licenses, new licenses, available allocations, or
trial licenses.

+ From the Filter by menu, choose how you want to filter your output.

Create a product license report - Export to Excel (CSV)

Select this option to export your full list of assets and data to Excel.
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1. Select the licenses you want in the report.

2. Choose the Export to Excel (.CSV) link. In the View my product screen, it’s above the list of
products. In the Manage my licenses screen, it’s at the bottom of the list.

3. Savethefile.

License Server administration without a console

December 18, 2023

There are several administration procedures that you can do without using the Citrix Licensing Man-
ager. We recommend that you use the console whenever possible. This article describes the proce-
dures required if you are unable to use a console.

+ Customer Success Services renewal files

« Delete license files

« Disable the domain name truncation on Windows
« Find renewal and maintenance expiration dates

You can use the licensing management tool on citrix.com to download, allocate, install, modify allo-
cations, return, and hide licenses. For more information, see Manage Licenses at citrix.com My Ac-

count.

You can use licensing commands to perform licensing tasks. For more information, see Licensing com-
mands.

Customer Success Services

After you download your Customer Success Services renewal license file from citrix.com, you must add
it to your License Server. Copy the Customer Success Services renewal license files to the same direc-
tory as your existing license files and reread (using Lmreread) the license files. For more information
about the lmreread command, see Reread license and options files (Imreread).

By default, this location is:
C:\Program Files\Citrix\Licensing\MyFiles ona32-bitserver
C:\Program Files (x86)\Citrix\Licensing\MyFiles on a64-bitserver

After you add the renewal license to your License Server, the license automatically unlocks any sub-
sequent versions of the product released during the Customer Success Services period.

To separate your licenses (two different licenses on two different servers):
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1. Select a second server and install the License Server software.
2. Go to citrix.com to modify and allocate your original licenses into two new files. These original
licenses are contained in your current license file on the original License Server.

« Allocate licenses to your first License Server for your first deployment.
« Allocate licenses to create another license file for the second License Server for your sec-
ond deployment.

3. Generate and download your Customer Success Services files and then copy them to the server
to which you want them applied.

4. Point all computers to the License Server running the version of the Citrix product you want
them to use. For information about pointing your Citrix product server to the License Server,
see your Citrix product’s administrator guide.

Delete license files

When you upgrade your edition (for example, Standard to Advanced, or Advanced to Premium) you re-
ceive new Citrix product licenses. You can allocate these licenses to one or many Citrix License Servers
through license files created at citrix.com. Rescinded licenses must be deleted from License Servers
within 90 days of new license purchase. Deleting the licenses enables:

« License asset management
« License compliance
+ Delete unnecessary alerts from appearing in the management console

Considerations when deleting files:

« Incorrect removal of license files might inadvertently lower the total licenses available.

+ Place any new license files on the License Server before deleting any licenses.

« Delete a license file only when all INCREMENT lines in the file are obsolete or unnecessary. For
example, every increment line was replaced with a new license because of an upgrade.

Important

Never delete the options file (citrix.opt) or startup license (citrix_startup.lic).

1. Atthe License Server, open the Services panel and stop the Citrix Licensing service.
2. Openthe Windows Explorer and navigate to where the license files are stored. By default license
files are stored in:

« C: \Program Files\Citrix\Licensing\MyFiles ona32-bitserver
« C: \Program Files(x86)\Citrix\Licensing\MyFiles on a64-bitserver

3. Back up all license (.lic) files.
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4. Using a text editor (we recommend Microsoft WordPad), open each license (.lic) file and identify
one or more obsolete license feature INCREMENT lines.

5. Ensurethatallincrement lines are obsolete or unnecessary. See License file format for informa-
tion about increment lines.

6. Close the file and change the file name extension from .lic to .old.

7. Inthe Services panel, restart the Citrix Licensing service.

8. Delete the renamed .old file.

Disable the domain name truncation
Warning

Editing the registry incorrectly can cause serious problems that might require you to reinstall
your operating system. Citrix cannot guarantee that problems resulting from the incorrect use
of Registry Editor can be solved. Use Registry Editor at your own risk. Be sure to back up the
registry before you edit it.

When you host multiple domains and multiple users who have the same user name on different do-
mains, you can leave the domain name truncation enabled. For example, jack@mycompany.com and
jack@newplace.com. If you have unique users on various domains, ensure that the License Server
does not truncate @domain.com.

The License Server detects Citrix Service Provider licenses and enables this functionality.

1. Locate the registry key:
For 32-bit machines: HKEY_LOCAL_MACHINE\SOFTWARE\Citrix\licenseserver

For 64-bit machines: HKEY_LOCAL_MACHINE\SOFTWARE\Wow6432Node\Citrix\
licenseserver

Name: UDUseDomain

2. Settheregistry key to 1.

Data Description
0 The domain field is truncated. (default)
1 The domain field is not truncated.

Find renewal and maintenance expiration dates

You must have unrestricted access to My Account.
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From a web browser, go to www.citrix.com.

Select Sign In > My Account and type your user ID and password.
Select Renew and Manage Maintenance Programs.

Select Manage Renewal Contacts at top of page.

ok wbn =

Renewal dates are listed next to each license under Current Expiration.

Licensing commands

October 7, 2023

While the Citrix Licensing Manager provides an easy method of accessing many licensing features,
you can also perform licensing tasks using commands. You might use the license administration com-
mands for advanced operations on the License Server that are not available in the console. Such
operations include diagnosing check-out problems using lmd-iag.

License administration commands are stored in:

« C:\Program Files\Citrix\Licensing\LS on a32-bitcomputer
« C:\Program Files (x86)\Citrix\Licensing\LS on a64-bitcomputer

Description of the licensing commands

Note:

In License Server version 11.16.6 build 34000, existing user management lmadmin.exe is re-
placed with Citrix owned user management lmgrd.exe. Ensure you do not use Lmadmin.

Licensing commands Description

Imgrd Starts and manages the licensing server and
other associated processes. Lmgrd is the core
licensing server file used for the Citrix licensing
Windows service. It hosts the license server port
(default 27000). Use the Citrix Licensing Manager
for licensing configuration and administration

tasks.
Imdiag Diagnoses license check-out problems.
Imdown Gracefully shuts down the License Manager and

Citrix vendor daemons (disabled by default).
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Licensing commands

Tmhostid

Imreread

Tmstat

Tmutil

Tmver

udadmin

CtxManageUserAndGroup

CtxManageUserAndGroup.exe —
useradd “domain\username” -Role *
admin/user”

CtxManageUserAndGroup.exe —
useradd “domain\username” —-Role *
adminGroup/userGroup”

Format license commands

Description

Reports the host ID of the server on which Citrix
Licensing is running.

Causes the License Manager daemon to reread
the license file and start the Citrix vendor

daemon.
Displays the status of a License Server.

Displays a list of licensing utilities or runs other
commands.

Displays version information for the licensing
binaries.

Displays all licensed users and devices and
deletes specified licensed users and devices.
This command applies to user/device licenses
only. To get a list of licenses, specify

udadmin -Tlist.

Configures user and group access to manage the
License Server.

Command to add a user.

Command to add a group.

Formatting conventions for the license administration commands:

Convention

Bold

Italic

Description

A command or switch, such as Imstat.

Replace variables with a value. For example, in
the expression: Imstat -c license_file_list. Before
you run the command, replace license_file_list
with the names of one or more license files.
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Convention

[Brackets]

Universal arguments

Description

Brackets around text indicate the options that
you can add to the command. It might indicate
that text within the brackets must be replaced.
For example:

Imstat [-a] [-c license_file_list
] [-f [feature]] can be written
as: C:\Program Files (x86)\Citrix
\Licensing\LS>lmstat.exe -a -c
@localhost —-f XDT_ENT_UD

Valid arguments for most license administration commands:

Argument

-all

-help

Description

Displays all information about the License

Server.
Lets you specify license files or License Server

port and host name. If you specify the path
without a license file name, the command
applies to all the license files in the directory. For
alocal host: —c @localhost. Foraremote
License Server: —c @servername. Fora
License Server in a cluster:

-c @clientaccesspointname. Fora
specified path: —-c path. For the names of one
or more license files:

-c license_file_list. Youcanenter
more than one license file path by separating
each path with a semicolon. Path names that
include spaces must be enclosed in double
quotes.

License handle, as reported by Imstat -a.
The license handle is a number used to identify a
specific checked out license.

Displays usage information and exits.
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Argument Description

-s [server] If you don’t specify a server, this argument
displays the status of all the license files listed on
the License Server or the license files on all the

License Servers.
-verbose Displays a longer description for all errors found.

Diagnose checkout problems (Imdiag)

The Lmdiag command allows you to diagnose problems when a product cannot check out a license.
In particular, you can test if your licenses are valid and if the License Server is running. When you run
this command, it attempts to check out a license.

You can also use the Tmdiag command to see if a specific type of license is working.
Example:

Run Umd1iagonyour Citrix Virtual Apps server Advanced edition licenses only. Specify MPS_ADV_CCU
as an argument.

Syntax:

Imdiag -c license_file_list [-n] [feature[:keyword=value]]

Argument Description

-c license_file_list Diagnoses the specified files. You can also
use:-c @localhostor-c @server-name

-n Runs in non-interactive mode. lmdiag does not
prompt for any input in this mode.

feature Limits the feedback to the specified feature.

keyword=value If a license file contains multiple lines for a
particular feature, the result is limited to the line
containing the text value. For example:

Ilmdiag -c @localhost MPS_ENT_CCU:
HOSTID=LICSERVO1 attempts a checkout on
the line with the host ID LICSERVO1. Keyword is
one of the following: VERSION, HOSTID,
EXPDATE, KEY, VENDOR_STRING, ISSUER
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If no feature is specified, Lmdi ag operates on all features in the license files in your list. The Imdiag

command displays information about the license, then attempts to check out each license. When
the checkout succeeds, Lmdiag indicates that the checkout was successful. When the checkout fails,
lmdiag gives you the reason for the failure. The Tmdiag command tries to connect to each TCP/IP
port on the License Server. It detects if the port number in the license file is incorrect. Imdiag lists
each TCP/IP port number that s listening, and if -c license_file_list is specified, diagnoses the specified
files.

The lmdiag command does not contact the computer running the Citrix product when it attempts to
check out licenses. The Tmdiag command indicates only if there are problems on the License Server.
That is, your product cannot check out licenses because it is pointing to the wrong License Server,
but Lmd1iag does not detect this problem. For example, a License Server that does not have licenses
for that product on it. The Lmdiag command reports that it can check out licenses when the Citrix
product is pointing to the wrong License Server.

Stop daemons (Imdown)

The Tmdown command shuts down the License Manager daemon and the Citrix vendor daemon on
your License Server or all License Servers on your network. The Tmdown command is disabled by
default.

Syntax:

Imdown -c license_file_list [-vendor CITRIX] [-q] [-all]

Argument Description

-c license_file_list or -c @localhost or -c @server  Use the specified license files. We always
recommend specifying
-c license_file_T1l1istwith Tmdown. You
canalsouse:-c @localhostor
-C (@server—-name

-vendor CITRIX Shut down only the Citrix vendor daemon. The
License Manager daemon continues to run.

-q Do not prompt or print a header. Otherwise,
Imdown asks “Are you sure? [y/n]: .”

-all If multiple servers are specified, automatically
shuts down all of them. -q is implied with -all.

Run the Tmdown command on a License Server. You can use -all to shut down all the License Servers
on your network.
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If Lmdown encounters more than one server and you didn’t specify the -all argument, the command
displays a choice of License Servers to shut down. For example, the -c argument specifies a directory
with many *.lic files. Shut down the remote License Servers by using -c and specifying the name of
the License Server.

Note:

If you use the Task Manager to terminate the License Manager daemon (Citrix Licensing Service),

stop the Imgrd process first, then stop the Citrix vendor daemon process.

To stop and restart the Citrix vendor daemon only, use lmdown -c @localhost -vendor
CITRIX, then use lmreread -c @localhost -vendor CITRIX to restart the vendor
daemon.

Checks the license server binding information (Imhostid)

The Tmhostid command returns the host ID of the License Server. You can use the command to
check the host name of your License Server. You can open a license file and compare the host name
in the license file to that of your License Server.

Note

Citrix Licensing, versions 11.5 and later for Windows allows you to display multiple host IDs if

there are more than one host.

Syntax:
lmhostid -bindingidentifier

where bindingidentifier isthe argument.

Argument Description

-ether Used for product licenses that are tied to the
MAC address of the appliance.

-internet Used for Windows-based Citrix product software
licenses that require a TCP/IP address.

-hostname Used for Windows-based Citrix product software
licenses that are tied to the host name of the
License Server. Note: The parameter
hostname is case-sensitive and must match
your License Server name exactly.
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Reread license and options files (Imreread)

The lmreread command causes the Citrix vendor daemon to reread changes to the license file and
the options file. After rereading, the Citrix vendor daemon uses the new settings and licenses from

then on.

You cannot use Lmreread remotely; run it locally on the License Server.
Syntax:

Imreread -c license_file_list [-all] [-vendor CITRIX]

Argument Description
-c @localhost or -c license_file_list Use the specified license files.
-all If more than one Lmgrd is specified, this

argument instructs all License Manager
daemons to reread.
-vendor CITRIX Specifies for the Citrix vendor daemon to be

restarted.

Examples:

o Imreread -c @localhost \[-all\]

« lmreread -c @client\\_access\\_point\\_name

« lmreread -c /opt/citrix/licensing/myfiles/CITRIX.lic -vendor
CITRIX

Display the list of licensing utilities (Imutil)
The Imutil command displays a list of licensing utilities when used standalone. When you specify
Tmuti Twith another command, it runs that command.
Syntax:
Tmutil
Tmutil other_command
Examples:

o lmutil

Displays all the licensing utilities.
e Imutil lmstat -c @localhost

Runs the Imstat command.
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Determine licensing status (Imstat)

The lmstat command helps you monitor the status of all licensing activities and provides you with
information about license check outs, including:

+ The product that checked out one or more licenses

» The checkout data

« The version of the license file

« The License Server name and port

« The date the license was checked out

« Information about the Citrix vendor daemon status and the license files

The lmstat command displays information that it receives from the License Server. The lmstat
command displays only one use of the license, even if there are multiple connections sharing that
license.

Syntax:

Imstat [-a] [-c license_file_list] [-f [feature]] [-i [feature] [-s[
server] [-S [CITRIX]] [-t timeout_value]

Argument Description

-a Displays all information.
-c @localhost or -c @server or -c license_file_list ~ Uses the specified license files.

-f [feature] Displays the products using a feature (product
license). If you don’t specify a feature, usage
information for all features is displayed.

-i [feature] If you don’t specify a feature, this argument
displays information from the INCREMENT line
for the specified feature (product license) or all
features.

-s [server] If you don’t specify a server, this argument
displays the status of all license files listed on the
License Server or the license files listed on all the
License Servers.

-S [CITRIX] Lists all product servers using the features
(product licenses) served by the Citrix vendor
daemon.

-t timeout_value Sets connection timeout to timeout_value. This

value limits the amount of time lmstat spends
attempting to connect to the License Server.
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The output from Ilmstat -c @localhost -a looks similar to this example. The lines in the ex-
ample might break because of the screen space.

License Server status: 27000@localhost

License file(s) on localhost: C:\Program Files (x86)\Citrix\
Licensing\MyFiles\citrix_startup.lic:C:\Program Files (x86)\
Citrix\Licensing\MyFiles\License.lic:

localhost: license server UP v11.15.0
Vendor daemon status (on LicenseServer):
CITRIX: UP v11.15.0
Feature usage 1info:

Users of CITRIX: (Total of 10000 licenses issued; Total of 1
licenses 1in use)

"CITRIX" v2038.0101, vendor: CITRIX, expiry: permanent(no expiration
date)
vendor_string: ;LT=SYS;GP=720;SA=0
floating license

XDT DDCPrinc-0001.citrix.com XDT XDT\_PLT\&MPS_PLT_2018.0518 (v1.0)
(localhost/27000 162), start Tue 5/8 17:59

Users of CTXLSDIAG: (Total of 10000 licenses issued; Total of 0
licenses in use)

Users of XDT_PLT_CCS: (Total of 200000 licenses issued; Total of 3
licenses in use)

"XDT_PLT_CCS" v2018.1201, vendor: CITRIX, expiry: 01-dec-2018
vendor_string: ;LT=Retail;GP=720;PSL=10;CL=VDS,VDA,VDE,VDP;SA=0;0DP=0;
NUDURMIN=2880; NUDURMAX=525600
floating license

XDT DDCAux-0001.citrix.com XDT G@OOO1E3A (v2018.0518) (localhost
/27000 534201), start Wed 5/9 15:17
XDT DDCAux-0001.citrix.com XDT @O001E81 (v2018.0518) (localhost
/27000 392504), start Wed 5/9 15:18
XDT DDCAux-0001.citrix.com XDT 0O0O1EOC (v2018.0518) (localhost
/27000 419703), start Wed 5/9 15:18
<!--NeedCopy-->

The following represents a breakdown of the information contained in the MPS_ENT_CCU line of the
Imstat output:
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Description

Citrix product name MPS The name of the Citrix product
that has the license checked
out.

Host name mps_serverl Computer where the Citrix
product is running.

Display MPS Name of the Citrix product that

has the license checked out.
Server host license_serverl Computer where the License

Server is running.

Port 27000 TCP/IP port where the License
Server is running.

Handle 203 License handle. The license
handle is a number used to
identify a specific checked out

license.
Checkout time start Wed 3/17 11:56 Time that this license was first

checked out.

The command lmstat -c @localhost -a can potentially generate much network activity in
systems that have many products licenses checked out.

You canuse Lmstat -a to verify license checkout data.

Display versions of binaries (Imver)

The Tmver command displays version information for the licensing binaries, such as the command
utilities.

Syntax:

Ilmver binary

Example:

Ilmver lmdiag

Display or release licenses for users or devices (udadmin)

The udadmiin displays the licensed users and devices and releases licenses for specified users and
devices.
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You can release a license for a user only when:

« The employee is no longer associated with the company.
+ The employee is on an extended leave of absence.

You can release licenses for devices only when the devices are out of service.
Caution:

Mass releases of licenses, before the automatic 90-day lease period, outside of the reasons high-
lighted earlier might violate the Citrix EULA. Before doing so, contact Citrix.

The udadmin command-line help displays usage information only in English, but you can use the
command on non-English systems.

Syntax:

udadmin [-options] [-delete | -events | -export | -list | -times]

Options Description

-f feature name When used with -list or -delete, displays or
releases the license for only the user or device
for the specified feature name.

-user user name Releases the license for only the user specified
by the user name.

-device device name Releases the license for only the device specified
by the device name.

-a Lists all features and versions installed on the
License Server.

Argument Description

-delete Releases the license for one user, feature, or
device at a time.

-events Reports all events logged by the user/device
licensing for each feature sorted in chronological
order.

-export Exports unprocessed user and device data. This

data is used to calculate license use and is not a
list of licenses in use. Citrix does not recommend
customers use this argument. It is used for
support or debugging only.
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Options Description

-list Displays the users and devices with licenses and
the time since the last update. If significant
activity occurred within 15 minutes of the last
report, the time to the next update appears.
Specifying -list -times generates output
containing a timestamp.

-times Specifying -list -times generates output
containing a timestamp.

No argument or? Displays usage information for the udadmin
command.

Examples:

- udadmin -list -times
Usage data is 0 minutes old. Next update in 15 minutes.
Users:
u01l.01 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)

u0l.04 XDT_ENT_UD 2017.1201 (Thu Sep 14 13:41:07 2017)

Devices:
D.ADV.23 XDT_ADV_UD 2017.1201 (Thu Sep 21 18:31:01 2017)
DO1 XDT_PLT_UD 2017.1201 (Tue Sep 12 14:30:33 2017)

- udadmin -list -a

Lists all features, versions, counts of licenses, and the users and
devices for each feature.

- udadmin -export

feature,userId,deviceld,deviceName,versionRequested,
versionUserAllocated,versionDeviceAllocated,time

- udadmin —-f XDT_ENT_UD -device dn01.88 -delete

Releases one device from one feature.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 109



Licensing 11.16.6

<!--NeedCopy-->

Clustered License Servers —configure, install, upgrade, and uninstall

October 7, 2023

Why clustered License Servers

Cluster servers are groups of computers that are combined to increase availability, reliability, and
scalability. Clustering the License Server lets users continue working during failure situations without
interrupting their access to critical applications.

How clustered License Servers work

When the active node in a cluster-enabled License Server suffers from hardware failure, failover occurs
automatically. Resources are available again in a few seconds.

A typical cluster configuration has, at a minimum, one active and one passive (backup) server. When
the active server in a cluster fails, the ownership of the resources in the cluster are transferred to an-
other node in the cluster. Typically, users cannot detect when one server in a cluster fails over to
another.

When the active node of a clustered License Server fails, there is no impact on users connected to
the Citrix product. The product might briefly enter the licensing grace period and an event might be
written in the product’s event log.

Important:

If Citrix Licensing is installed in a clustered environment and Windows Firewall is enabled,
connections can fail. Connecting remotely to the console or checking out licenses works until
failover occurs in the cluster. Exception rules for CITRIX.exe and Imgrd.exe are created during
the installation of Licensing, but do not work after a cluster failover. To work around this issue,
create exceptions for Licensing components on the Exceptions tab of the Windows Firewall
panel. Create an exception for each of the following ports:

« License Server port number is 27000
» Vendor daemon port number is 7279
+ Web Services for Licensing port number is 8083
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Citrix Licensing in a clustered environment

Like most clusters, a private network is used to send heartbeats, commands, and state information
between the nodes of the cluster. If the connection is interrupted, the nodes try to reconnect by the
private network first, then the public network. The following diagram illustrates a cluster-enabled
licensing deployment:

Communications in a clustered licensing environment:

Product Froduct Froduct
SErver Server SEMVEr

Public Cluster Connection

Node 1 Private Cluster Connection Mode 2

Shared
Dl sk

Only one node can use the resources in a cluster at any given time. If you already deployed Citrix
Licensing and you want to migrate your deployment to a cluster-enabled server, keep the following
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points in mind:

« Because you already generated license files that reference a specific server name, you must give
the client access point the same name as the original License Server. If not, then rehost your
license files with the new name of the License Server cluster.

« Host names in license files are case-sensitive; therefore, the client access point names must be
the same case as the host names in the licensefile. If they are not, you must rehost your license
files with the correct capitalization of the names. You can use the Failover Cluster Manager to
ensure that the client access point name matches the host name specified in the license file.
Cluster and host name case is not an issue if you use Studio in Citrix Virtual Apps and Desktops
or the Citrix Licensing Manager (from the Start menu on your License Server) to download your
licenses.

+ Point all product installations (for example, servers running Citrix Virtual Apps and Desktops)
serviced by the old License Server to the new License Server cluster. Change product communi-
cation settings so that they use the name of the client access point as the License Server name.
For information about editing product-side communication settings, see the product’s docu-
mentation.

Prerequisites to configure a clustered License Server

The following list outlines the requirements for setting up a License Server in a Microsoft Cluster:

Microsoft clustering functionality exists in:

- Windows Server 2019
- Windows Server 2016
- Windows Server 2012 R2

« Citrix Licensing does not support Clustered Shared Volumes or third party Volume Management
products for clusters.

+ Before configuring Citrix Licensing for Microsoft clustering, you must have a fully functional Mi-
crosoft cluster environment. Citrix Licensing Services runs on only one node at a time.

+ To cluster the License Server, follow these cluster requirements in addition to any requirements
from Microsoft for hardware and clustering in general.

« Install licensing on the cluster with the License Server installer CitrixLicensing.exe.

« When you install Citrix Licensing on a cluster, specify the name of the client access point. You
are prompted for the name of the License Server during product installation.
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+ We recommend that you use identical License Server hardware for each node in the cluster. In
particular, Citrix recommends two network adapters on each node and the servers configured
with a shared disk.

+ Ensure that each node has two network adapters. One for the connection to the public network
and the other for the node-to-node private cluster network. We do not support using one net-
work adapter for both connections.

+ The public and the private IP address must be on different subnets because the Cluster Service
recognizes only one network interface per subnet.

« Aname resolution method, such as DNS, WINS, HOSTS, or LMHOSTS, is necessary to resolve the
client access point name.

+ Each server that forms the cluster must be in the same domain.
« Set static IP addresses for the private network connector.
+ We recommend that you use the Citrix Licensing Manager to allocate licenses to the cluster.

+ When you generate a license file at citrix.com, use the name of the client access point when
prompted for the Host ID.

+ After you download a license file, copy ittothe F: \Program Files\Citrix\Licensing
\MyFiles folder (where F: is the shared drive for the cluster) on the License Server and reread
it.

Important:

Citrix recommends setting static IP addresses for all network adapters in the cluster, both private
and public. If using Dynamic Host Configuration Protocol (DHCP) to obtain IP addresses, access
to cluster nodes might become unavailable if the DHCP server goes down. If you must use DHCP
for your public network adapter, use long lease periods to ensure that the dynamically assigned
lease address remains valid even if the DHCP service is temporarily lost or perform a DHCP reser-
vation.

Configure a clustered License Server

The following steps describe the overall process involved in installing and configuring licensing on a
cluster-enabled server. These steps assume you configured the clustering on the hardware on which
you intend to install the License Server.

1. Create a cluster resource group. Assign a client access point and shared storage to the resource
group. Ensure that the first node has control of the cluster resources and the resource group
you created points to the first node.
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2. On the first node of the cluster, start the Citrix Licensing installer, CitrixLicensing.exe, as an ad-
ministrator. Install it on the first node to the shared cluster drive (not the quorum drive). Leave
the Last Node in the Cluster check box cleared.

3. Move the resources from the active node in the cluster to the second node.

4, Install the License Server on the second node to the same shared location as the first node. You
can add more than two nodes to a cluster.

5. Wheninstalling the License Server on the last node in the cluster, ensure that you check the Last
Node in the Cluster check box.

6. Obtain license files that specify the client access point name of the License Server as the host
name. After obtaining license files, you must add them to the License Server and then reread
them.

7. Configure your Citrix product to use the client access point name, not the node name of the
License Server cluster.

Important:

When a clustered License Server fails over, the cluster service renames the Imgrd_debug.log to
the name of the node that previously hosted the services. Then it starts the services on the new
active node and creates a Imgrd_debug.log.

Install licensing on a cluster-enabled server

Important:

The .msi does not support clustering. To install or upgrade for clustering, use CitrixLicensing.exe.

The following drive letters and paths/variables are used in this procedure:

+ Disthe drive for your product media.
« Cisthelocal hard drive on the specified node.

» Fistheclustershareddriveresource. (Thisdriveistheinstallation drive. Thatis, the place where
installation files used by each node are stored.)

Because of a NetBios restriction, ensure that the client access point name is fewer than 15 characters.
On non-English platforms, when starting a License Service installation on a cluster node, the Cluster
Group list on the Configure screen might contain the system default Cluster Group. Select one of the
non-default Cluster Groups and the installation continues normally.

1. Create a separate, noncore cluster resource group. The resource group must have the attached
storage assigned a drive letter and a client access point. The client access point must have the
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same host name used when obtaining the license file. Use the Failover Cluster Manager and
Roles > Configure Role in Windows Server 2012 R2, Windows Server 2016, and Windows Server
2019. Then select the Other Server type in the menu. Ensure that the first node of the cluster
owns all cluster resources.

2. Run the License Server installer, CitrixLicensing.exe, as an administrator.
On the Install Location page, set the drive letter to correspond with the cluster shared drive.
By default, the licensing components are installed in F:\Program Files\Citrix\
Licensing.

3. Leave the Last Node in the Cluster check box cleared during the installation on the first node.
4. Move the resources for the resource group you created in Step 1 to the second node.
5. In node 2 of the cluster, run CitrixLicensing.exe as an administrator.

6. Go back to Step 3. You caninstall more than two nodes on the cluster. You can install more than
two nodes on the cluster. For each additional cluster, repeat Step 3.

7. When installing the License Server on the last node in the cluster, ensure that the Last node in
the cluster check box is checked. The last node is where the ports are configured.

8. Use the Citrix Licensing Manager to import your license files.

Open the console or run commands

Alllicensing administration features available in standard deployments are also available on clustered
License Servers. These features include the management console and the ability to run license admin-
istration commands.

Browse to the following location to open the Citrix Licensing Manager in a cluster:
https:

Where the client access point name is the name of the cluster and the web service port is the port
number for console communications. The default port number is 8083. To specify the location of the
license files in the cluster, you can run many license administration commands using the argument -c
@client access point name. For example:

Ilmreread -c @client access point name -all

Upgrade a clustered License Server

To upgrade your clustered License Server (from versions 11.12.1 onwards) to the latest version, com-
plete the following steps:

1. Download the latest License Server build.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 115


https://www.citrix.com/downloads/licensing/

Licensing 11.16.6

Run the License Server installer CitrixLicensing.exe as an administrator.

Move the resources for the resource group you created when you installed licensing on a clus-
tered enabled server, to the second node.

In node 2 of the cluster, run CitrixLicensing.exe as an administrator.
If you have more than 2 nodes on the cluster, repeat Step 3.

Use the Citrix Licensing Manager to import your license files.

Known issue

When you begin the upgrade steps, an unnecessary Configure Ports page appears. You can safely
ignore it and click Next. [LIC-1434]

Note:

If you are running a version of a License Server older than 11.12.1, uninstall it and then install
the 11.16.6 version. These older versions of License Server do not conform to current Microsoft
cluster guidelines. The 11.16.6 version of the License Server has the functionality required to

support Windows Server versions 2008 and later.

Uninstall a clustered License Server

Uninstall licensing from a clustered License Server using the Control Panel > Programs and Features

option from the active node.
Ensure that the first node contains all the resources.

5.

From the first node in the cluster, start Control Panel > Programs and Features.
Remove Citrix Licensing.

Using the failover cluster manager, move the resources in the Citrix Licensing resource group to
the second node.

Remove Citrix Licensing from the second node. If there are more nodes, repeat Steps 3 and 4
for each node, and then proceed to Step 5.

Remove the remaining files from the shared drive.

Note:

The uninstallation process does not remove the license files and options file from the shared

drive. For more information, see Troubleshoot Licensing.
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Disaster recovery - back up and redundancy

December 18,2023

Depending on how crucial the applications associated with your licenses are, you might want to create
backup License Servers. Although Citrix stores backup copies of your licenses, downloading many
replacement licenses can be time-consuming. If the License Server fails, you can store backup licenses
on a network file share, or have a configured backup License Server ready.

You can use the same licenses for your disaster recovery site that you use for your production environ-
ment.

+ Configure and manage your disaster recovery environment independently of your production
environment.

« Don’t use both the production and backup License Servers to service license checkouts at the
same time.

« Make only one License Server accessible at any one time

« The License Server in your disaster recovery environment must have an identical host name to
the License Server in your production environment.

When the License Server is offline for maintenance activity

The standard 30-day grace period allows your systems to continue to function without degradation of
performance or denial of service to support License Server maintenance requirements.

What can | do if my License Server is unrecoverable?

When you have a backup copy of your license files available, you have 30 days to do the following:

1. Rename an existing server in your environment to have the identical host name as your original
License Server.

2. Install the License Server component and your backup license files to relicense your environ-
ment.

What can | do if my License Server is unrecoverable and | do not have a backup copy of
my license files immediately available?

When you don’t have a backup copy of your license files immediately available, you have 30 days to
access your My Account > Manage Licenses portal at www.citrix.com. To relicense your environment,
do the following:
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1. Download your license files.

2. Rename an existing server in your environment to have the same host name as your original
License Server.

3. Install the License Server component and the license files you downloaded.

What can | do if my License Server is unrecoverable and | cannot rename an existing
server in my environment?

When you can’t rename an existing server in your environment, you have 30 days to relicense your
environment. Do the following:

Identify another server in your environment.

Install the License Server component.

Access your My Account > Manage Licenses portal at www.citrix.com.

Return and reallocate your license files using the host name of the new server you selected.

ok wpn

Download and install these license files.

Does any failure of the License Server degrade performance or deny service to users?

No. The 30-day grace period prevents you from experiencing degradation in performance and denial
of service to users.

Redundancy solutions

Setting up redundancy solutions might be necessary only in mission-critical environments. For
smaller or less mission-critical deployments, you can back up your License Server by creating a
duplicate License Server and store it on or off the network.

You can ensure redundancy for your mission-critical environments by:

+ Creating a clustered License Server. For more information about clustering and licensing, see
Setting up the License Server on a Microsoft Cluster.

+ Using the high availability feature on XenServer minimum release version 5.6.

+ Duplicatingthe License Server and its contents. Give the duplicate computer the same name as
the active License Server and store it off the network.

« Storing another License Server that has a different server name on the network. In this case,
when the active License Server fails, you must change the backup server name to start using it
as the active License Server.

+ Using a network appliance. If you are using only one License Server to service license requests
at any time, you can use a network appliance that detects server or network outages and route
traffic to a backup License Server.
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All methods let you exchange one server license for another without a loss of service, provided the
exchange occurs within the grace period. For more information, see Grace period.

Remember these key points:

+ Because license files reference the server specified during allocation, you can use the files only
on a server that has the same binding information. That is, the server name or FQDN or MAC
address (possibly displayed on the portal as an Ethernet address) as the original License Server.

« You cannot have two License Servers that have the same name on your network active at the

same time.
« Add any other licenses that you download to both the active License Server and the backup

License Server.

Troubleshoot the License Server

December 7, 2023

If any of the licensing services fail to start, the cluster detects that licensing is offline and tries to restart
the service three times (by default). When these attempts are unsuccessful, fail over to the next node
begins. The cluster tries to start the services on the second node. When the attempts fail on the second
server, the process might enter into an infinite loop. In this case, the computers running the Citrix
products fall into the grace period. During the grace period, client connections are not affected.

Troubleshoot the cluster-enabled License Server

When troubleshooting a cluster-enabled License Server, try the following:

« If you move the resources to the other node, do you still see the issue?

« If the installation fails, ensure that you don’t enable the User Account Control (UAC) when in-

stalling on a cluster.

+ For Windows Server 2019, Windows Server 2016, and Windows Server 2012 R2:

1. Inthe Failover Cluster Management window, from the left pane, select the cluster. In the
middle pane, the summary information for the cluster appears.

2. Select the Cluster Core Resources title to expand the section.

3. Verify that the cluster resources are all online (green arrow).
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The “-evaluation license-"warning message

After you replace the evaluation license files on the License Server with new license files, the Citrix
product might display the following license expiration message when users log on: Warning:
The following Citrix Product is using an Evaluation license. This

license will expire 1in...

To resolve this issue:

1. Deletethe old evaluation license files from the License Server. For more information, see Delete
license files.

2. Atthe License Server, restart the Citrix Licensing service.

3. Atthe Citrix product server that needs license validation, point to a fictional License Server and
then point the product back to the actual License Server. (See your product documentation for
information about changing these settings.)

4. If the problem persists, restart the product server (for example, Delivery Controller).

Required product licenses are not installed on Director or Studio

The following error message is displayed on the Citrix Virtual Apps and Desktops Director or Studio
ul:

» Required product licenses are not installed
« Trial period has expired

The following reasons can cause the error messages:

» Novalid licenses are installed on the License Server
+ Product Edition and Product Model are not set correctly on Citrix Studio
« If the maintenance dates of the licenses are not compatible with the product version installed

To resolve this issue:

1. On Citrix Studio, check if the licenses are reflecting the correct maintenance dates. If not, real-
locate and import renewed licenses. For more information, see the Citrix article CTX134629.

2. Verify if Citrix Studio is pointing to a valid License Server.

3. Click Edit Product Edition under Actions and choose correct licensing edition or model as per

the licenses applied.

« If the right edition or model is set and still the error remains, toggle between the license
editions and then choose the correct one.
« Ifthe above steps do not work, click “change license server’under actions and click con-

nect.
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4. Relaunch Citrix Studio and then reboot the product server if the issue still persists.
Note:

License Server VPX is not compatible with Citrix Virtual Apps and Desktops (Version 7.x and
above).

License Server VPX

October 7, 2023

Important:

The License Server VPXis deprecated and won’t receive any further maintenance or security fixes.
Customers using 11.16.6 or previous versions of License Server VPX are advised to migrate to the
latest version of License Server for Windows as soon as possible.

The License Server VPX is a self-contained Linux-based virtual appliance that allows deployment of
licensing in your Citrix environment.

The License Server VPX section of the Citrix Licensing documentation contains information that is
specific to the License Server VPX. The rest of the Licensing documentation set contains articles that
apply to only Windows or to Windows and VPX.

Limitations

These items are not supported with the License Server VPX.

+ Supplemental grace periods.
« Citrix Licensing Manager:

- The Citrix Licensing Manager is available on the License Server VPX only if you configure
Active Directory and install the keytab file.

- Enable and disable the supplemental grace period.

- Modify ports License Server (default 27000), Vendor Daemon (default 2729)

- Displaysthe License Serverversion in the top bar of the screen. If you click the down arrow,
the hostname, Ethernet address, and IPv4 address appear.

- License usage dashboard.

+ Upgrades - See Export the database for use in a different License Server VPX.
« Clustered servers.
+ Use the Linux iptables command to change License Server VPX default ports.
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What’s new in License Server VPX

October 7, 2023

What’s new in the License Server VPX build 33500
Version upgrades

+ Apache version 2.4.46
+ CentOS version 7.9
« OpenSSL version 1.1.1h

Fixed issues

« DNS server configuration was added to the VPX configuration during static IP setup. [LIC-3270]

Known issues

+ An unknown error appears the first time you import the license file from the Citrix Licensing
Manager. As a workaround, refresh the page and try again. [LIC-3343]

» You cannot SSH/SCP as a root user for security reasons. As a workaround, to SSH/SCP as a new

user:

- Login as root via XenCenter.
- Use useradd to create a new user.
- Use passwd to create a password for the new user.

What’s new in the License Server VPX earlier builds
Version upgrades

» Apacheversion 2.4.41

+ jQuery version 3.4.1
CentOS version 7.7

« OpenSSL version 1.1.1d
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Fixed issues

+ After a CEIP upload failure, the log file location doesn’t appear in the error message dis-
played on the Citrix Licensing Manager. The log file location is /opt/citrix/licensing/L-
S/logs/log_ctxuploader.txt. [LIC-396]

« The user name of the logged on user displayed on the Citrix Licensing Manager page is in the
domain\user format. The Citrix Licensing Manager of a License Server for Windows displays the
user name as user@domain.

Known issues

+ Sometimes after a few failed attempts to join Active Directory, when the Active Directory inte-
gration succeeds, you might see an LDAP error during the initial configuration of the License
Server VPX. As a workaround, run resetsettings.sh and reenter the details.

+ If you access the Citrix Licensing Manager from outside the domain to which it has been joined,
you might be prompted for credentials multiple times. You must change your browser settings.
For more information, see https://techsupport.osisoft.com/Troubleshooting/KB/KB01223.

+ The operating system reserves ports 1 through 1024. When configuring the VPX ports, use ports
higher than 1024. By default, VPX uses port 8082 for SSL, which is open in the firewall. If you
choose a different port for SSL, reconfigure the firewall in the iptables.

+ A network error might appear the first time you access the Citrix Licensing Manager from the
Chrome browser. As a workaround, refresh the page.

Requirements for installing License Server VPX

October 7, 2023

Citrix Hypervisor (formerly XenServer) must provide adequate virtual computing resources to the Li-
cense Server VPX as listed in this table.

Memory

2 GB. Sufficient for up to 500 Citrix servers and approximately 50,000 licenses. Monitor available mem-
ory during operation to determine if you require more memory. For larger environments, we recom-
mend allocating more memory.
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Citrix Hypervisor or XenServer version

« Citrix Hypervisor 8.2
« XenServer7.0

Minimum storage requirement

10 GB on the default Storage Repository inside the XenServer pool.

Virtual CPU (vCPU)

1 vCPU. For larger environments or those using user/device licensing, consider adding a second
vCPU.

Browsers

We tested the following browsers. Other browsers might work, but all functionality might not be avail-
able.

+ Microsoft Edge
 Mozilla Firefox
« Chrome

« Safari

Get started with the License Server VPX

December 7, 2023
Download the License Server VPX from Citrix Licensing Version 11.16.6.0.

We distribute the Citrix License Server VPX as a virtual machine system configured in . xva format.

Ensure you have the latest License Server

When upgrading or installing new Citrix products, always have the latest License Server. The new
License Server is backward compatible and supports older products and license files. However, new
products require the newest License Server to check out licenses correctly. You can install or upgrade
the latest version from the product media.
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If you are unsure if your License Server version is current, verify it by comparing your version with the
number on the Downloads site.

To find your License Server version number on the License Administration Console:

1. Openaweb browserand goto https:
2. Click Administration and select the System Information tab. See the release version in the
information list.

Directory and file locations

+ License file location: /opt/citrix/licensing/myfiles
Keytab file location: /opt/citrix/licensing/LS/conf/ctx_http.keytab
+ server.crt and server.key location: /opt/citrix/licensing/LS/conf/

+ Loglocations: /opt/citrix/licensing/LS/logs
» Reportlog: /opt/citrix/licensing/LS/reportlog.rl
« Customer success service renewal files: /opt/citrix/licensing/LS/

To import License Server VPX using Citrix Hypervisor

1. Open XenCenter, click the server on which to import the License Server VPX, and select Import.

2. Browse to the location of your package and choose the . xva package.

3. Choose a Home Server for your VM. This Home Server is the server on which the VM starts auto-
matically. Alternately, you can click a Citrix Hypervisor pool and the VM automatically starts on
the most suitable host in that pool.

4. Choose a storage repository for the virtual disk. The repository must have a minimum of 8 GB
of free space.

5. Define network interfaces. The License Server VPX communicates on a single virtual NIC.
Choose a network that is accessible to the Citrix Servers to which you want to provide license
services.

After you import the VM, it appears inside your XenCenter management console. You can restart the
virtual appliance in Citrix Hypervisor by right-clicking on its name and choosing Start.

Configure the License Server VPX for first use

After importing the License Server VPX, you have a fully functional Citrix License Server on your Cit-
rix Hypervisor pool. The first time you start the License Server, a setup wizard opens to configure

networking.

1. After the wizard opens, create a strong root password for administrators.
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2. Specify a host name for the License Server VPX.
Most Citrix license files are tied to the case-sensitive host name of your License Server.
3. Specify a domain for the License Server VPX.

4. Specify whether to use DHCP as your network type. Choose y to obtain network information
automatically. Otherwise, choose n, and type the required network information.

5. Specify a License Administration Console user name and password for the licensing service.

6. Choose whether to enable the Customer Experience Improvement Program and Call Home. For
more information, see About the Citrix Customer Experience Improvement Program (CEIP).

7. Choose whether to add the VPX License Server to the Active Directory domain. If you do, after
the setup is complete, follow the instructions to generate and install the key tab file.

Important:

If you don’t configure Active Directory, then Citrix Licensing Manager, Studio, and Director inte-

gration are unavailable.

Configure licenses from a web-based interface, available on port 8082

If you make a configuration error, log on to the appliance as root with the password you specified.
Type the command resetsettings.shorreset_ceip.sh torerunthe setup wizard.

resetsettings.sh command

resetsettings.sh provides the option to retain or delete historical data files while resetting the
Licensing Server VPX configuration. You can fully reset the configuration by deleting all historical data
collected until that time or partially reset the configuration by retaining the historical data.

As root, run the following script and make your choices:

# resetsettings.sh

reset_ceip.sh command

reset_ceip.sh provides the option to reset the Customer Experience Improvement Program
(CEIP) options you chose during the original configuration. This command resets only the CEIP
settings and retains all other settings.

On VPX, do not modify the CITRIX.opt file.

As root, run the following script and make your choice of CEIP [1.DIAG 2.ANON 3. NONE]

#reset_ceip.sh
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Export the database for use in a different License Server VPX

Usethemigrate_historical_data.sh script to migrate the historical data to a newer Licens-
ing Server VPX. The script provides options to back up and restore historical data.

Important:

Run this script as root.

This example procedure migrates the data from VPX_0 to VPX_N.

1. Run the command # migrate_historical_data.sh -bon VPX_O to create a back-up
file ftmp/historical_data.tar.

2. When VPX_Nisrunning, copy or move the /tmp/ historical_data.ta file to VPX_N using any file
transfer protocol. For example, scp.

3. Runthe#tmigrate_historical_data.sh -r /directorycommandonVPX_Ntore-
store the data. Where directory is the directory in which historical_data.tar resides.

Generate and install the keytab file

1. Use the ktpass.exe utility from a Windows server that is connected to the same domain.
Type the command on one line without returns. The following example shows multiple lines
due to space limitations.

ktpass.exe -princ HTTP/hostFQDN:port@DOMAIN REALM -mapuser domainuser -pass pass-
word -out filepath -ptype KRB5_NT_PRINCIPAL

Where:

-princ HTTP/hostFQDN:port@DOMAIN REALM specifies the principal name:
hostFQDN is the Fully Qualified Domain Name of the License Server VPX.

port is port configured for Web Services for Licensing. Default is 8083.
DOMAIN REALM is the Active Directory domain typed in UPPERCASE LETTERS.

-mapuser domainuser specifies a user in the domain that can be used to bind to Active Direc-
tory.

-pass password specifies the domain user password.
-out filepath specifies the path where the generated keytab file is saved.

-ptype KRB5_NT_PRINCIPAL specifies the principal type. KRB5_NT_PRINCIPAL is the only
supported principal type.

Example:
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ktpass.exe -princ HTTP/VPXHOST.example.domain.com:8083R@EXAMPLE.
DOMAIN.COM -mapuser administrator -pass password —out C:\example.
keytab -ptype KRB5_NT_PRINCIPAL

2. Rename the generated keytab file to ctx_http. keytab.
3. From the License Server VPX command line interface, mount a network path.
a) Create and share a folder with the ctx_httpd.keytabfileinit.
b) On the VPX, create a mount point, mount the shared drive, and copy the file.
mkdir /mnt/temp
mount //your_windows_machine/shared_folder/ cp /mnt/temp/
ctx_http.keytab /opt/citrix/licensing/LS/conf
¢) Unmount the drive on the VPX.
umount /mnt/temp
4. Copy the generated keytab file using the Windows share to this path on the License Server VPX.
Jopt/citrix/licensing/LS/conf/ctx_http.keytab
5. To access the Citrix Licensing Manager, open https: //VPXHOST.example.domain.com
18083/
6. To bind the Active Directory, log on using the user configured in the command in step 1.
7. To configure and administer other domain users, log on to the Citrix License Administration Con-
sole:
https://VPXHOST.example.domain.com:8082
8. Add and remove Active Directory users.
Important:

+ License Server VPX doesn’t support Active Directory groups.

+ Because Kerberos authenticates the Active Directory users, the keytab file generation is cru-
cial.

« AsperKerberosrules, you must map a unique user against the principal name created using
ktpass.exe. For more information, see the ktpass command article.

+ The port in the service principal name (SPN) is required for Studio to display and manage
licenses.

« SSH/SCP is disabled for the root user. Create a new user to access the VPX with SSH/SCP.

Disable domain name truncation on the Citrix License Server VPX

The License Server detects Citrix Service Provider licenses and enables this functionality.

© 1999-2024 Cloud Software Group, Inc. All rights reserved. 128


https://technet.microsoft.com/en-us/library/cc753771(v=ws.11).aspx

Licensing 11.16.6

On the command line, go to the /opt/citrix/licensing/LS/conf/ud_settings.
conf file.

2. Using the vi editor, set CTX_UD_USERDOMAIN=1.
3. Restart the License Server VPX or the Citrix Licensing daemon.

Setting Description
CTX_UD_USERDOMAIN=1 Use the user domain from user
profile. Disables domain name
truncation.
CTX_UD_USERDOMAIN=0 Use the user domain from user Do not use the user domain

profile. Disables domain name  from user profile. (default)
truncation.

Move license files from an older License Server VPX version

This procedure moves only the license files. Reconfigure all the users on the new License Server. En-
sure that the license files that you move have the correct ownership and permissions.

1.

Back up the license files from the old Citrix License Server VPX to a network share.
Allthe *.liclicensefilesfrom: /opt/citrix/licensing/myfiles exceptcitrix_startup.lic

2. Close the old License Server.
3. Spin up the new Citrix License Server VPX with the same binding as the older one. The binding

might be a MAC address or host name or IP Address specified in the SERVER line of the license

files.

. Restore the backed-up license files from the Network Share to the new License Server. Restore

the files to: /opt/citrix/licensing/myfiles with the file ownership as ctxlsuser

: lmadmin (user:group) and permission as 644.

. Run this command as ctxlsuser: /Jopt/citrix/licensing/LS/lmreread -c

@localhost

Change port numbers

The Linux kernel reserves Ports 1 through 1024. When configuring the VPX ports, use ports above
1024. When using SSL, use port 8083 for the Citrix Licensing Manager and port 8082 for the License
Administration Console, which is openin the firewall. If you select a different port for SSL, reconfigure

the firewall in the iptables.
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Citrix Licensing Manager

December 7, 2023
Important:

The Citrix Licensing Manager operates automatically within the License Server for Windows. The
Citrix Licensing Manager is available with the License Server VPX if you configure Active Directory
and install the keytab file.

The Citrix Licensing Manager enables the following features on a License Server using a simple web
interface:

«+ Force data uploads to Citrix.

«+ Simplify data export by allowing you to select individual products, license models, all Customer
Success Services (Subscription Advantage) dates.

+ Change the Web Services for Licensing port (default 8083).

« Configure historical data retention by selecting a retention period. Default data retention is one
year.

+ Simplified installation of license files on the License Server using a license access code or down-
loaded file.

« Display details of licenses after they are installed.

+ Configure Citrix Customer Experience (CEIP) and Call Home at any time.

+ Retry failed citrix.com and Customer Experience Improvement Program uploads.

+ Configure Configuring Subscription Advantage renewal (also known as Customer Success Ser-
vices) license actions. You can specify whether to check automatically or manually for renewal
licenses and whether you want notification of renewal licenses or the licenses installed.

+ Store and export historical usage reports from the License Server VPX on which the tool is in-
stalled. You can specify a date range for the historical usage data and export it to a CSVfile. The
CSV file provides daily usage information including the number of licenses in overdraft.

« Important notifications of license availability, expiration, and other conditions. Use the bell icon
at the top of the Citrix Licensing Manager screen to display notifications.

Settings

Display the Settings by clicking the Settings gear icon on the top of the screen. Use this screen to set
the Server Configuration, which includes:

+ Configuring the License Server port
« Configuring Subscription advantage renewal (also known as Customer Success Services) license
actions
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+ Share usage statistics with Citrix. For more information about the data collected, see Citrix li-
censing Customer Experience Improvement Program (CEIP), Call Home, and compliance usage
and analytics programs.

+ Knowing the status of your uploads. If uploads fail, information appears with suggestions to fix
the issues.

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Server Configuration

HTIPS Port {default 8083) Language Retention Period

koaz B English v‘ ‘ 1 Year e

Diays te retain histerical usage dara.

Subscription Advantage Renewals

(@) Automatically check for Subscription Advantage renewal licenses and notify
~ when available. Learn hiore

oy Automatically check for and install subscription Advantage renewal licenses
when available

(1 hdanually check for Subscription Advantage renewal licenzes

Share usage statistics with Citrix

Help us improve Citrix products by providing License Server and basic usage statistics. (0

(1 Allow Citrix Insight Services to safely collect basic usage and statistical information to better
understand customer usage.

(@ Send anonymous statistics and usage information to the Citriz Customer Experience
~ Improvement Program (CEIP).

(1 Donotsend any data to Citrix.
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Upload information

Provides status for the last Citrix Customer Experience Improvement Program (CEIP), Call Home, or Citrix Service
Provider Program upload

Last successful upload Not available

s

© An upload to cis.citrix.com failed due to Error code 10 - "Netwaork Failure HTTP Error connecting to citrix.com®. An
automatic retry is attempted in 24 hours, but you can click Retry now to try again. Ifthis message doesn't resolve itself
see the troubleshooting steps below.

s/ Stepstotroubleshoot

CEIP data elements for Citrix License Server 11.16.6 build 33500

LSInfo GUID
DateSampleStopUTC
DateSampleStop
SARenewalCheckOption
EncoreSamplingPeriod
EncoreRetentionTime
EncoreEnabled
UDUseDomain
OptFileNoLogStatus
OptFileComplianceConfig
UDUserNameCase
UDDeviceNameCase

Inventory Feature ID

UDBIinFileCreatedUTC

UDReportGenerationUTC

EventLog TimelLapse
UpgradeV2
Corruption
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FirstCreation

RemoveUser

RemoveDevice

SADate DateSampleStartUTC

DateSampleStopUTC

CountUsedMax

Active

Countlinstalled

Pool DateExpiration
VendorStr
Countlinstalled
CountOverdraft

StartupCounts LPE ID

Count

Call home data elements for Citrix License Server 11.16.6 build 33500

LSInfo GUID
DateSampleStopUTC
FQDN
DateSampleStop
SARenewalCheckOption
EncoreSamplingPeriod
EncoreRetentionTime
EncoreEnabled
UDUseDomain

OptFileNoLogStatus
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OptFileComplianceConfig

UDUserNameCase

UDDeviceNameCase
Inventory Feature ID

UDBinFileCreatedUTC

UDReportGenerationUTC

EventlLog TimelLapse
UpgradeV2
Corruption

FirstCreation

RemoveUser

RemoveDevice

SADate DateSampleStartUTC

DateSampleStopUTC

CountUsedMax

Active

Countlinstalled

Pool Serial
DateExpiration
VendorStr

Countlnstalled

CountOverdraft
StartupCounts LPE ID
Count
SerialNumbers Serial ID
SADate
SN
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Compliance data elements for Citrix License Server 11.16.6 build 33500

LSInfo GUID
Inventory Feature ID
SADate CountUsedMax
Serial
StartupCounts LPE ID
Count
Historical use

The Citrix Licensing Manager stores and exports historical usage reports from the License Server VPX
on which you’ve installed the tool. You can specify a date range for the historical usage data and
export it to a CSVfile. The CSV file provides daily usage information, including the number of licenses
in overdraft.

You can also view and specify the amount of time to retain the data.

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Historical Use

IUse these filters te export a License Sen.rer[%roduct usage report for the specified time pericd a5 a .csv file.

Product & Edition Model

‘ Citrix Edgesight for Endpoints (CESEF_ENT) v ‘ | Concurrent o |
Subscription Advantage Date Start Date End Date

‘ 206201200 v‘ | 03/26/2020 [# ‘ ‘03,’26[2020
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Install licenses

Considerations - Be aware of these considerations when using the Citrix Licensing Manager to allocate
and download licenses:

+ The License Server requires internet access or configuration with a proxy server.

« After you click Allocate and Download, you cannot cancel it. If the Allocate and Download fails,
use My Account at citrix.com.

+ The Citrix Licensing Manager allocates most license access codes but doesn’t support redown-
loading or reallocating of license files. You can return licenses on citrix.com and use the Citrix
Licensing Manager to allocate them again. For redownloading, use My Account.

« If you rename the License Server, you must reallocate any license files allocated under the old
License Server name.

« The Citrix Licensing Manager gives you the option of choosing how to obtain your licenses:

- Use license access code
- Use downloaded license file

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Install Licenses

Cheeose the methed teinstall licenses on the License Senver

License Server Information

Hosthame IP Address

‘foU can cheose teinstall licenses by using the license access code or alicense file [lic).

® Use license access cade Use downloaded license file

License Access Code

Enter License Access Cade

Use license access code:

1. Select Use license access code and type the license access code (which is supplied in an email
from Citrix) and choose Display Licenses. Your license entitlements display and you can choose
which licenses and the quantity to install.
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2. Select a product from the displayed list, type the number of entitlements to install, and choose
Install. To select more than one product, choose a product, click Install, choose the next prod-
uct, click Install, and so on. They are processed in order. After you install all the licenses for a
specific license access code, you cannot use that license access code again. If you must perform
more transactions with that code, log on to My Account.

Citrix Licensing Manager

Historical Use Install Licenses Update Licenses

Install Licenses

Cheoese the methed e install licenses on the License Server.

Lizense Server Information
Hostname IP Address
fou can choose teinstall licenses by using the license access code or a license file (i)
(@) Use license access code ) Use downleaded license file

Licensze Access Code

ctress

Display Licenses

License Entitlements

Product Name Quantity/Avallabla Alraady Used Actlon/Prograss

Citrix XenDeszktop Platinum Edition - Per User/Device 4 /4 1 Install

Citrix XenServer Platinum Edition 4 /4 1 Install

Citrix xenDesktop Platinum Edition - Per User/Device 4 /4 1 Install

Use downloaded license file:

1. Select Use downloaded license file, choose a file, and check the check box if you want to replace
and older file with the same name.

2. Click Import. The Citrix Licensing Manager displays information about the licenses.

3. If your license file is successfully uploaded to the License Server, a message displays.
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() Use license access code (@ Use downloaded license file

Licensze File

Choose File IMPS_RETAIL_1GP_15A_1CCU_G-

Ifa duplicate file [s found, replace the old file

Note:

If you experience issues uploading a license file, remove any special characters in the file name
and ensure that the file has a . 11 c extension (all lower case).

Update licenses

You can check for available Subscription Advantage (Customer Success Services) renewal licenses.
When licenses are available, the list of licenses, quantity, and Subscription Advantage date display on
this screen. You can download and install the licenses. This screen lists any licenses installed in the
last 30 days.

i% Licensing Manager

Historical Use Install Licenses Update Licenses

Update Licenses

License Server Informatfan

Hostname | IP Address

Subscription Advantage renewal licenses available I,\\, Check for Available Renewals

Mo renewal licenses are available

Subscription Advantage renewal licenses installed in the last 30 days

Mo renewal licenses were installed
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Troubleshoot License Server VPX

December 7, 2023

Active Directory integration
These errors are the most commonly encountered errors during integration of the License Server VPX

to Active Directory:

« ERROR: Cannot find user

- The domain user account being used is not found in the target domain.
- Trust domains are not supported. You might see this error if a user belongs to any trust-
ed/parent domain and is not a part of the target domain.

« ERROR: User does not have access

- Ensurethatthe domain user has the right privileges to join the machine to Active Directory.
- For more information, see this Microsoft Support article.

« ERROR: Cannot contact the domain

- Correct the domain name or check if the domain is reachable from the License Server VPX
and fix any network related issues.

« ERROR: User has insufficient permissions to join the domain
- The account does not have the privileges required to join a machine to Active Directory.

For more information, see this article.

For any other errors, see this article for details.

Keytab creation

If you see any issues during the keytab creation, follow these instructions and retry:

1. Ensure that you have elevated permissions when running the ktpass.exe command. Run
the cmd prompt as Administrator.

2. Ensure that the User Account Control (UAC) restrictions are minimal.

3. Ensure that all password requirements are met. For example, password filters aren’t blocking
password characters on the target domain and you are specifying a supported number of char-
acters.
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4. Retry the command by adding the domain to account used in the -mapuser argument.
Use a user principal name (account@domain.com) or a down-level logon name (do-
main\username).

5. Ensure that the account being used is a member of the target domain and not of a trusted or
parent domain.

6. Add the -target argument to the command and pass the domain.

a) Ensure that the account used in the -mapuser argument is a service account created
solely for this purpose.

b) Ensure that the first name, last name, and the service account name for the account are
the same.

¢) We recommend that you name the account with the name of the License Server VPX name
to ensure that uniqueness is maintained during mappings.

For more details, see the ktpass command article.

Manually install a certificate

Use this procedure if you are a Director or Studio administrator who doesn’t want to use the self-
signed certificate that is generated during installation.

Install the .crt and .key files on the License Server:

VPX - License Administration Console:

1. Stop Citrix licensingetc/init.d/citrixlicensing stop.

2. Copy the server.crt and server.key created earlier in this procedure to /opt/citrix/
licensing/LS/conf/.

3. Start Citrix licensingetc/init.d/citrixlicensing start.

VPX - Web Services for Licensing:

1. Stoptheservicesetc/init.d/ citrixwebservicesforlicensing stop.

2. Copy the server.crt and server.key created earlier in this procedure to /opt/citrix/
licensing/WebServicesForLicensing/Apache/conf/.

3. Starttheservicesetc/init.d/ citrixwebservicesforlicensing start.

Configure a proxy server for use with Citrix Licensing Manager, Customer Experience
Improvement Program (CEIP), and Call Home

You can use a proxy with the Citrix Licensing Manager, CEIP, and Call Home. When you configure
a proxy server, requests to download licenses and upload Call Home data are sent through a proxy
server.
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Important:

Citrix Licensing components requiring outward bound web communications can inherit network
proxy settings using Windows automatic proxy detection. We do not support authenticated prox-
ies. For more information about Windows automatic proxy detection, see WinHTTP AutoProxy
Functions.

Configure a proxy server manually

Editthe SimpleLicenseServiceConfig.xmlfile, whichisin /opt/citrix/licensing/WebServicesForLice

/.

Add a line of xml to the file in the format <Proxy>proxy server name:port number</
Proxy>. The .xml tags are case-sensitive.
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